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Introduction
Welcome to L4U Library Software - Library Management Made Easy!™ The staff 
at L4U Library Software would like to thank you for your purchase. We are confident 
that you will find our software to be a valuable tool in ensuring the efficiency of your 
library operations.

About this Manual
Every L4U installation with Web Server allows patrons to search the collection via 
the iPAC (Internet Public Access Catalog). L4U Freedom™ licensed users are 
granted administrative access to the collection via the iPAC. This user guide provides 
detailed information for L4U on the Web and all of its functions.

The L4U User Manual is a separate manual and provides detailed information on the 
Administration Utility for both L4U Enterprise™ and L4U Platinum Elite™. Please 
note that some iPAC and Freedom options are configured with in the L4U program 
and are therefore explained in the L4U Users Manual. The manuals provide step by 
step instructions with any differences in operating systems noted in the text. Screen 
shots may appear in either Macintosh or Windows format throughout the manual.

Before using this manual, you need to install the L4U Platinum Elite program using 
the installation instructions provided with your software package. L4U Enterprise 
Users would have this done for them by their Support group. A quick overview of the 
product and possible feature revisions are also available in the Quick Start Guide. We 
recommend you keep the installation instructions with the manual. If you must rein-
stall L4U, please refer back to the installation guide that you received with the soft-
ware or consult L4U Client Corner later in this chapter.

L4U documentation assumes you have a working knowledge of your operating sys-
tem and its conventions, including how to use a mouse, standard menus and com-
mands. You should also know how to open, save, print and close files. For more 
information on these techniques, consult the documentation that came with your com-
puter.

Notational Conventions
• Dialog box names, options, menu names, button names, and menu commands 

will appear in Italic type.
• Case sensitive characters, that are required to be typed as is, will appear in 

Bold.
• Shortcut options may be provided and will appear in square brackets (Exam-

ple: [Ctrl 1]).
• Navigating through the menus will be represented with the “>” symbol. 

(Example: Choose File > Import File, means select the sub-menu Import File 
from the File main menu).
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Keyboard Conventions
• Names of keys that you type will appear in SMALL CAPITALS (Example: TAB 

and SHIFT)
• A plus sign (+) between two key names means that you must press those keys 

at the same time (Example: “Press ALT+TAB”, means that you hold down ALT 
while you press TAB).

• You can choose menu commands by pressing the key combination listed next 
to the particular menu command. For example, in Windows “CTRL+Y” or in 

Macintosh “ +Y” may be used to reach the circulation screen. These are 
referred to as shortcuts.

Icons
The following table describes the icons that are used throughout this manual.

Navigating Freedom
Navigating Freedom is quick and easy using the Freedom Toolbar (page 67) or the 
Freedom Dashboard. Individual functions within Freedom (ie: Library File, Acquisi-
tions, etc) have their own Toolbar. Also, some of the buttons on the Dashboard will be 
different depending on which function you are currently in.

The Freedom Toolbar

Icon Description

Context Sensitive Help is available throughout the iPAC and 
L4U Freedom wherever this icon appears. Click this icon to 
display the relevant information in the L4U Manual.

Notes contain explanations of possible results or alternative 
methods of performing a task. These notes may also suggest 
best practices.

Contains warnings about possible loss or damage of data.
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Freedom Dashboard
Once in one of the Freedom Functions, the Freedom Dashboard is avail-
able to navigate to a previous or next record as well as to Save your edits 
or to Cancel to discard your edits. Use the Freedom Dashboard navigation 
buttons (ie: Save, Next, Previous, Cancel, etc) and not the Internet 
Browser Forward and Back buttons.

Tips and Tricks for Data Entry or Data Management
The following tips are considered good practice when using an Internet 
Browser and will help you during your day to day activities.

• Press F11 on the keyboard to dismiss the Internet Explorer/
Firefox navigation buttons. Press F11 to bring them back. More 
of the Freedom screen is now visible. Apple’s Safari has similar 
commands via the View menu.

• Pressing TAB will take the text insertion point to the next entry 
field and SHIFT + TAB takes the text insertion point to the previous 
field.

• All fields with associated Authority Files or Control Files utilize drop down 
lists for easy entry. In the appropriate field, type in the first few characters and 
a list containing all matches will appear. Click the correct entry to select. If no 
match is found, simply continue typing.

• When entering data into a Control File field (Loan Type, Department, Loca-
tion and so on), a complete list of all available codes can be viewed by typing 
@.

• To Delete a line of unwanted data, click the X icon to the right of the 
unwanted line and to Add, click the Plus icon.

• Log Out of Freedom instead of just closing the Internet Browser window. 
This will give you the chance to save your session (ie: bookbag, etc).

Company Profile
L4U Library Software has been developing library automation software since 1985 
and our Management Team has been working with the educational marketplace since 
1980. The Library 4 Universal™ product is the result of countless suggestions from 
users, prospects and librarians from all over the world.
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L4U Library Software offers a complete range of products and services designed to 
meet the needs of the K-12 school library marketplace. All items are available in 
either Windows or Macintosh configurations.

• L4U Enterprise - Our main product is Library 4 Universal™ Enterprise. 
This is a platform independent school library management system designed 
for the K-12 marketplace. L4U Enterprise is a set of features designed for use 
in a centralized environment such as a school district. This solution consists 
of the L4U Enterprise Admin Utility software and L4U Freedom.

• L4U Platinum Elite - Platinum Elite is targeted for smaller installations and 
is ideally suited for this environment. L4U is sold in either Single User 
(Standalone) or Multi User (Network) configurations and supports Windows 
XP/Vista/7 or Macintosh OS 10.4.x or greater operating systems.

• Library 4 Universal Add-Ons - In addition to the L4U software, we offer 
additional products for use with L4U.
• Advanced Bookings is a more robust and feature intensive version of 

L4U designed to facilitate the needs of a District Resource Centre or any 
other site requiring long term reservations and shipping controls.

• L4U iPAC and L4U Freedom enables a library to publish its collection 
as a web site, thus allowing unlimited remote access for student searches 
through a standard HTML browser. In addition, L4U Freedom offers web 
access to most L4U Administrative functions used in day to day opera-
tions of a library.

• L4U Enterprise is a set of features designed for use in a centralized envi-
ronment such as a school district. This solution consists of the L4U Enter-
prise Client software and L4U Freedom.

• CheckMARC is a MARC record collection from which you can search 
and obtain MARC records. CheckMARC is used directly from the Acqui-
sitions area within the L4U program and is purchased as an online sub-
scription.

• Support Packages - L4U Library Software provides various support pack-
ages which include options such as email, fax, phone and online technical 
support. Some support packages also contain product patches and upgrades.

• Training - Product Training is available in a variety of formats. Online train-
ing is available via a web connection as individual or packaged modules. Pre-
viously recorded training CD’s are available on a variety of topics. Certified 
trainers are available for on-site training or in-house training (held at L4U 
Library Software head office).

• RECON - Retrospective Conversion Services are offered for customers that 
are not currently automated. This is a straightforward process where the 
library ships its traditional shelf list to our office and our staff converts this 
information to an electronic format known as MARC21. Once converted, 
these MARC records can be imported into any library management system 
including L4U. 

• Conversions - Convert existing library management systems (MARC, 
MicroLIF, ASCII exports) to L4U format. L4U Library Software can convert 
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most automation systems to L4U without rebarcoding or re-entering your col-
lection. Process and pricing vary depending upon the format of your current 
data.

• Scanners, Printers and Consumables - Barcode Labels of various sizes and 
formats, Label Protectors, Client Cards, Barcode Readers and printers, Porta-
ble Inventory Scanners and Slip Printers are also available from L4U Library 
Software 

L4U Resources
There are several resources available to assist you with the L4U program. To com-
pletely understand and utilize all the functions and features available, we recommend 
you take advantage of these resources.

Show Me
Show Me is an audio visual tool that is designed to enhance your under-
standing of the L4U program. A pop up video explains what the feature 
does and how to use it. Look for this icon in key areas of Administrative 
L4U. If you are interested in purchasing Show Me and would like infor-
mation and pricing contact:
Sales@L4U.com

Training
Product Training is available in a variety of formats. Online training is available via a 
web connection as individual or packaged modules. Previously recorded training 
CD’s are available on a variety of topics. Certified trainers are available for on-site 
training or in-house training (held at L4U Library Software’s head office). Informa-
tion on our Online training options can be found in Client Corner at:http://
www.L4U.com

Context Sensitive Help
Context Sensitive Help is available throughout the iPAC and 
L4U Freedom wherever these icons appear. Click this icon 
to display the relevant information in the L4U Manual.

Support Packages
In a continuing effort to provide the best customer service possible, we offer a choice 
of support packages. They include options such as toll-free phone support, free 
upgrades, remote access for problem solving and access to tech notes. If you have 
purchased a support package, details are provided with your software package. If you 
are interested in purchasing support and would like information and pricing contact:
Sales@L4U.com
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Web Site
L4U users can keep up to date on the latest releases and news by visiting our web site. 
Useful Tech Notes and Frequently Asked Questions (FAQ’s) can also be accessed 
from the web site. Visit us anytime:
http://www.L4U.com

Client Corner
Client Corner is a limited access area of the L4U Website (http://www.L4U.com). Cli-
ents with valid Support Packages are issued user ID’s and passwords to view these 
pages. Information such as current software releases, Quick Tip Archives, Tech Notes 
and account information are all accessible using your password. Through Client Cor-
ner, you can request support, report a program defect and enter a feature request. All 
requests are automatically logged in L4U Library Software’s internal client manage-
ment system and reviewed by Support and Development technicians.

On-Line Help
L4U has the added feature of on-line help. If you are in the program and have a ques-
tion, simply access the on-line help from within the program and you will be directed 
to a virtual manual. Simply click your way to an answer.

Email Support
Email is a wonderful tool for obtaining support for your L4U software. In addition to 
a quick response time, you also have the ability of attaching files such as screen shots 
and import files. The attached information helps the technician understand your par-
ticular concern much faster. To access our support department through email, simply 
send an email to:
Support@L4U.com

Listserver
All current accounts are added to the L4U Listserver. Subscribers will receive weekly 
tips and announcements regarding program updates, product releases and sales spe-
cials throughout the months of September to June. This is an optional service and 
users can unsubscribe at the click of a mouse.

Telephone Support
Telephone support is included with most Support Packages. This service can be avail-
able via a toll free number, 24 hours a day, 7 days a week. Our technicians will be 
happy to answer any questions that you may have about your L4U software. In order 
to answer your call as quickly as possible, please have the following information 
available.

• Customer ID #
• Library name
• A telephone number where you can be reached
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• Whether this is a new call, or a previous incident (If it is a previous incident, 
please have the incident number available)

During the telephone support process you will be issued an incident number for your 
call. This incident number will remain with your support record indefinitely. If you 
are calling about an ongoing issue, simply provide the incident number to any techni-
cian and they will be presented with the complete call history.

At times, you may be asked to perform some tasks on the computer. If your phone is 
not next to the computer, you may have to complete the call with the technician, work 
on the computer, and then have the technician contact you again. For this reason it is 
imperative to have a number at which we can reach you. If your site has automated 
voice mail, please ensure our technicians know how to reach you for after hours inci-
dents.

Real Time Support & Help via WebEx

Using Cisco WebEx Support Center, L4U Support can deliver instant, personalized 
remote support to users regardless of location. Using WebEx, L4U Support can 
shorten call times, increase first call resolution, minimize onsite service visits, and 
reduce overall support costs. WebEx services are available to all Support Packages 
that include call in support.
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Configuring L4U iPAC
The iPAC (Internet Public Access Catalog) is the interface that patrons use to access 
the library collection. Patrons can search, view details, sort result lists, create book-
bags and if licensed for L4U Freedom, much more. L4U Freedom is the web version 
of the L4U Admin Utility. Before any connections can take place, the L4U iPAC must 
be configured in Preferences in the L4U Platinum Elite Admin Utility or the Enter-
prise Admin Utility.

Enabling iPAC
The L4U iPAC must be enabled in Preferences prior to connecting with a browser. 
This is required regardless of the type of connection(s) patrons will be using. To 
enable iPAC:

1. File > Preferences
2. Click L4U iPAC
3. Select the Configura-

tion & Startup tab
4. For Launch L4U iPAC 

at Startup, click Yes
• This should be the 

default settings for 
any blank or con-
verted data file 
supplied by L4U 
Library Software

5. Select any other 
required options
• see “Setting Configuration Options” on page 5 for an explanation of available 

options.
6. Click Save
7. File > Quit to exit L4U
8. Restart L4U
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iPAC Connection Types

iPAC Connection Types are either Internal or External. The Internal iPAC may be 
accessed directly from within L4U Admin Utility by clicking Start the iPAC at the 
Login Screen (see “Login Screen” on page 17 in the L4U Users Manual). The Internal 
iPAC does not support iPAC Search Results Display features or Freedom functions.

An External iPAC connection is an internet browser running on any other computer 
on the L4U computer’s intranet or internet.

L4U installations that are licensed for L4U iPAC or L4U Freedom have an unlimited 
number of connections via the Internet. This license can be applied to either Single 
User or Multi User configurations.

iPAC (LAN Client)
The Internal iPAC differs from the web client iPAC, because it can be converted to an 
Administration station by changing password levels. Click the Start the iPAC button 
to access the Internal iPAC when first starting the L4U program. If currently in an 
Administration screen, access the Internal iPAC by Selecting, File > Change Pass-
word Level and click Start the iPAC. The Internal iPAC has a limited feature set com-
pared to the External iPAC.

iPAC (Browser)
Users that are licensed for L4U iPAC or L4U Freedom, have an unlimited number of 
connections to their collection. Patrons connect to the collection from a browser on 
any Intranet or Internet enabled computer. To connect to L4U from a browser:

1. Launch a web browser on any Internet connected computer
2. In the Address field, Enter the IP Address of the L4U iPAC computer

• This is usually an L4U Server (Enterprise or Platinum Elite) or L4U Single 
User

3. Click Go or Press ENTER

4. The L4U iPAC will load and the main search page will display

Note: L4U Platinum Enterprise/Elite 3.1 works with the current versions of the fol-
lowing internet browsers: Apple Safari, Microsoft Internet Explorer, Google 
Chrome & Mozilla Firefox. To access the L4U iPAC easy, create a shortcut 
on the desktop or create a bookmark in the browser.
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Locating an IP Address
In order to connect to the server from a browser, it is necessary to know the IP (Inter-
net protocol) address of the computer publishing the library collection. It is easy to 
determine the IP address in L4U:

1. With L4U Admin Utility running, do one of the following
• Application Menu (L4U Elite or L4U Admin Utility) > About L4U (Mac OS)
• Help > About L4U (WIN)

2. The IP Address of the L4U Server is displayed in the Server IP Address field

If the IP address(es) of the server is not known, consult a computer technician to help 
with the following steps.

Macintosh OS X (10.5 - 10.7)
1. Apple menu > System Preferences
2. Click Network
3. From the Sidebar, click on the interface that has a status of Connected. 

For desktop computers this is usually Ethernet; for portable computers, 
it is usually Airport or Wireless.
• The machines IP Address is displayed

Windows 2003/XP/Vista/Windows 7
1. Start > Run

• Windows 7 Users, just click the Start button
2. Type CMD and click OK

• Windows 7 Users, just press ENTER

3. In the DOS screen that pops up, type IPCONFIG.
4. Press ENTER

• The machines IP Address is displayed

Record the IP Address exactly, including periods (dots). This IP address is used in the 
address bar of the Internet Browser program to access the library records. Use the for-
mat: http://IP Address:Port Number where the IP Address is the series of numbers 
determined above and the Port Number is the port number set in Preferences, see 
“Publishing the L4U iPAC” on page 7. A Port Number is only required if the default 
port 80 is not used. An example of an address would be 
http://139.142.220.198:8080, which would be acceptable for a Mac L4U Server.

Note: For most configurations the computer acting as L4U iPAC Server must have a 
static IP address. If unsure whether your computer has a static IP Address, 
please consult your local computer technician.
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Setting Configuration Options
When setting up the L4U iPAC server there are a number of options to consider. For 
Example: which computer will publish the collections, what language will the iPAC 
be displayed in, how to customize the look of the iPAC, etc. The following pages 
describe these options and how to set them up. These options are found at File > Pref-
erences > L4U iPAC > Configuration & Startup.

Allow Auto Login
This option must be enabled to allow Auto Login to the iPAC. Requires Active Direc-
tory and Internet Explorer 9. Please refer to “iPAC Auto Login” on page 24 of the 
L4U Users Manual.

Convert Diacritics
The convert diacritics option is used for collections that contain materials cataloged in 
languages that employ diacritics (accents). The diacritics must be converted from 
either the Macintosh or DOS character set to the ISO character set. In other words, the 
accents must be converted to display correctly on a web browser. This option is not 
necessary for collections that do not contain diacritics and by turning this setting off 
response time may improve. To ensure that diacritics display correctly:

1. File > Preferences
2. Click L4U iPAC
3. Beside the Convert Diacritics (é, è, etc.) option, click Yes
4. Click Save

Home Page
The Home Page is the first page displayed when a patron accesses the iPAC. By 
default this page is set to home.shtm. The start or home page of the iPAC can be 
changed; however, this should only be done by someone knowledgeable in web 
design and under the direction of L4U Software Support.



L4U Web Manual

6

iPAC Server Log
All activity on the iPAC that 
is conducted via a browser is 
logged in the Web Server 
Log. This log contains the IP 
address of a computer making 
a request, when the request 
was made, what the request 
was and the IP of the Server 
that responded. This informa-
tion is accessed through Pref-
erences. Additionally, you 
can decide how long you 
would like to retain this infor-
mation. To access the web log options:

1. File > Preferences
2. Click L4U iPAC
3. By entering a value in the field provided or by using the slider to right of the 

field, Enter the number of Days between log flush
• This is the length of time you wish to maintain the web server log and is 

flushed automatically.
4. To view the web activity, 

click the Web Requests 
Log button
• Exit the log by clos-

ing the window
5. Click Save to exit the 

Preferences screen.

Maximum Hits allowed in iPAC Searches
Any time a search is conducted, L4U compiles a list of hits that comply with the 
search criteria. By setting a maximum, the Administrator can limit the number of 
returned hits per search. This becomes especially useful when a patron enters a vague 
or broad search criteria. A search result consisting of hundreds of records may be 
overwhelming to a new or younger user, as well as slow down the network. To set the 
maximum number of hits allowed enter the preferred value in the field provided. 1500 
is the default value and recommended.
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Bibliographic View Punctuation
If Search Results Display is 
set to display in Biblio-
graphic view (see “Biblio-
graphic” on page 45), these 
options will attempt to cor-
rect punctuation inconsis-
tencies in the collection to 
conform to the Modern Lan-
guage Association (http://
www.mla.org/) guidelines. 
The L4U data is not 
affected, only the iPAC dis-
play of the data. To modify 
these settings:

1. File > Preferences
2. Click L4U iPAC
3. The options in Bibliographic View Punctuation are:

• Do not add extra punctuation: Display the data unaltered.
• Add bibliographic punctuation: Add appropriate punctuation between the 

fields (e.g.: author, title, publication information, etc.)
• Normalize bibliographic punctuation: Add or omit appropriate punctuation 

where necessary.
4. Click Save to exit the Preferences screen.

Publishing the L4U iPAC
The L4U iPAC Server is an 
integrated component of the 
L4U application and does 
not require a separate server. 
In a single user installation, 
the same machine running 
L4U is also the iPAC Server. 
However, multi-user instal-
lations can be configured to 
publish the collection from 
either the L4U Server, the 
Patron’s computer(s) or 
both. This flexibility is use-
ful for accommodating firewalls, and allowing for the display of different iPAC skins 
simultaneously. By default the iPAC Server publishes on the L4U Server or for a Sin-
gle User L4U installation on the L4U computer using Port 80, but this can be changed 
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for network security requirements. Mac OS X can use port 8080 as default or use 
another available port. To change these default settings:

1. File > Preferences
2. Click L4U iPAC
3. Select the Configuration & Startup tab
4. In the Port To Listen field, Enter the required port.

• Ensure the port entered has been opened on the network.
5. From the Publish On drop down list, Select which computer(s) patrons will 

access via their web browser.
6. Click Save

Note: Log in as Library Patron at the L4U Platinum Elite Admin Utility station to 
publish the iPAC at that station.

Multi-Homing
If the computer used for L4U iPAC Server has two network cards and you only want 
to use one for the iPAC server, L4U system settings must be changed. Go to File > 
Preferences > L4U iPAC > Configuration & Startup tab. Enter the IP Address of the 
network card to be used. Click Save. If the L4U Server doesn’t have multiple network 
cards and it is desired to have L4U publish on the IP Address assigned to the built in 
Network Card then leave this field blank.

District Logo
Use this feature to display 
another graphic in place of 
the L4U logo which appears 
in the iPAC and Freedom 
pages. Locations can have 
their own Logo and if 
defined, will override this set-
ting in Preferences.

Requires QuicktimeTM 
installed on the L4U Server 
computer. For better blend-
ing of the logo image with the 
web page the image file should be in either PNG or GIF89 format and should have no 
background. Using JPEG images is acceptable but not recommended. The maximum 
size of the placeholder on the web page for the logo is 94 x 315 pixels. It is recom-
mended to create a logo image with exactly 94 pixels of height or less and a width of 
315 pixels. The image will be resized if it exceeds the size of the placeholder. Resiz-
ing may lead to picture quality deterioration.
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To change the graphic:

1. File > Preferences
2. Click L4U iPAC (if necessary)
3. Click Upload
4. Click OK at the Quicktime warning
5. Click OK at the Image Type alert
6. Click Upload
7. Navigate to the new graphic and Click Open

• An alert will display if the graphic does not meet recommended specifications
8. Click Save to exit the Preferences screen.

Note: No Conversion When Uploading Logo: Enable this setting if the desired 
graphic meets the requirements and the graphic background is still opaque on 
the L4U web pages. Repeat steps 1 thru 6 above, but check this option before 
clicking Save. The graphic is then stored externally on the Enteprise Server in 
the Server\Server Database\Web\images\Logo folder and not in the Current 
Datafile.

Update Voting
This button gives access to the Elections Module. Please refer to “Setting Up an Elec-
tion” on page 290 in the L4U Users Manual for more information.

iPAC and Freedom Customization
Please refer to page 18 for more information on customizing the default look of the 
iPAC and “Freedom Customization” on page 31 for Freedom customization options.

Search Options
There are a number of options available concerning searching and display within the 
iPAC. These include the default boolean operators used when phrase searching, the 
format in which search results are displayed, and how hyperlinks are utilized.
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Allow Reserves/Bookings from the Web
If licensed for L4U Freedom, 
you can choose to allow or 
disallow item reserves to take 
place from the Web. To set 
this option, File > Prefer-
ences > L4U iPAC > Search 
Options tab and click in either 
Yes or No beside Allow 
Reserves/Bookings from 
iPAC. This setting turns Web 
reserves on or off for all 
patrons. If you wish to allow 
reserves for some or all 
patrons, you then configure the Web Privileges in Homerooms. Please refer to “Set-
ting Web Privileges” on page 27 for more information on how to configure these 
options. For more information on placing reserves via a web browser, see “Reserves” 
on page 70 or, if placing reserves from Freedom Circulation, see “Placing Reserves in 
Freedom Circulation” on page 146.

Show Item Ratings
If licensed for L4U Freedom, 
you can choose to allow or 
disallow the display of Item 
Ratings. To set this option, 
File > Preferences > L4U 
iPAC > Search Options tab 
and click in either Yes or No 
beside Show Item Ratings. 
This setting prevents patrons 
from seeing this feature and 
rating items. Please refer to 
“Book Ratings” on page 49 
for more information on how 
to place and view Item Ratings.

Show Social Network Links
Social networking links are available so patrons can like and share their favorite 
books with friends via Facebook, Twitter, My Space and other popular sites. Enabling 
this feature may frustrate some patrons if these features are blocked by your IT 
Department or District policy.
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Authority vs. Item Display
Display of search results within the iPAC fall into two categories: by Item or by 
Authority.

Item
Item display shows the 
patron the individual 
library items in more 
detail from the search 
result list. This is best 
option if the library has 
a wide variety of users 
and different ages. Item 
display may also show 
duplicate items, 
depending whether 
Copy Management is 
enabled or not. All 
items will show as sep-
arate items if Copy 
Management is not 
enabled Please refer to 
“Copies View” on page 13.

 Authority
Using Authority 
display of search 
results shows as a 
list of hits match-
ing the search crite-
ria and the number 
of items attached to 
it. Example: When 
searching Author, 
the resulting list 
will be of Authors’ 
names only, with 
the number of 
library items by 
those individuals. The user may then click on a specific Author to view all 
items by that Author. Authority display is not available for Keyword or 
SoundsLike searches.
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To select which format search results are displayed in:

1. File > Preferences 
2. Click L4U iPAC
3. Select the Search Options tab
4. Under Default Search Display, 

Select either Authority or Item
5. Click Save

New Items Search Options
The L4U iPAC uses a toolbar that is consistent throughout all screens and can be 
found at the top and bottom of each page. This toolbar has a New Items button. This is 
used to quickly view all items that are new to the collection. By entering a value 
(number of days) in Preferences, the librarian can determine how long an item is con-
sidered ‘new’. L4U determines whether an item is deemed new by comparing the cur-
rent date to the Entry Date of the item plus the value entered in Preferences. To adjust 
this value, go to File > Preferences > L4U iPAC > Search Options and Enter the 
desired value in the field provided for Number of days items stay new.

Matching of Hyperlinks
When a patron views the item details of a specific record, some of the data appears as 
a hyperlink. For Example: Author, Series, Subjects. Patrons can click these links to 
perform searches using the hyperlink data. For Example: While viewing the item 
detail of a record the patron clicks the Author name which displays as a hyperlink, 
Atkins, Peter William. A search is then conducted using Atkins, Peter William. as the 
search criteria. When the Preference option Use Exact Matching on Hyperlinks is set 
to Yes, L4U will only return records that contain author data that exactly matches the 
hyperlink. If this Preference option is set to No, L4U will return items with author 
entries that contain Atkins or Peter or William.To adjust the Hyperlink option, go to 
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File > Preferences > L4U iPAC > Search Options and Select either Yes or No for the 
Use Exact Matching of Hyperlinks option. 

Copies View
The iPAC will display all copies of the items by default. If this option is selected, 
search results will show only one copy of an item that has multiple copies. Copy 
Management has to be enabled in Preferences for this feature to work. For more infor-
mation on “Copy Management” on page 38 in the L4U Users Manual.

• With Copies View enabled: 
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• Without Copies View enabled:

Combining Search Terms
When a patron uses more than one word as their search criteria, L4U can handle the 
search using one of two boolean operators as the default. If the default is set to OR, a 
more expansive list of items will result. For Example: If a patron enters Dog Cat as 
the search criteria, the results will include item records containing the words Dog or 
Cat or both Dog and Cat. The more restrictive, or more accurate search, would be an 
AND search. Using the same example, the results would include only item records 
containing the words Dog and Cat. Search types available on the Home page of the 
iPAC are Keyword/Soundslike and table specific searches (i.e. Subject, Title, Author, 
Series, Ed/Illus). For more information on iPAC searches, see “Searching Tech-
niques” on page 37. The default operator for these two types of searches are set up 
separately. To set the default operators:

1. File > Preferences
2. Click L4U iPAC
3. Select the Search 

Options tab
4. For the Authority Key-

word Searches, Select 
OR or AND
• This operator is 

used when search-
ing Subject, Title, 
Author, Series, and 
Ed/Illus

5. For the Keyword/
SoundsLike searches, 
select AND or OR
• This operator is used when searching Keywords, SoundsLike and pressing 

ENTER
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6. Click Save

Note: All blank data files and conversion data files provided by L4U Library Soft-
ware will have the Preference default for all searches set to AND.

Keyword Search Options
By default, iPAC keyword searches perform a Starts With search. In other words, a 
Keyword search of cat would return, catatonic, catch, Catholic, etc. This functionality 
can be changed so only items are found where the keyword is equal to the search cri-
teria. In the same example, the search would return Cat In The Hat, Cat Goes Fid-
dling, The Dog and the Cat Go Out, etc. Searches can automatically be pluralized as 
well. 

To set these options:

1. File > Preferences
2. Click L4U iPAC
3. Select the Search 

Options tab
4. For the Add wildcard to 

Keyword Searches, 
Select Yes or No
• If set to No, L4U will 

find only items where 
the keyword is equal 
to the search term.

5. For the Add an ‘s’ to 
Keyword Searches, select 
Yes or No
• This setting is only applicable if the Add wildcard is set to No. 

6. Click Save

Creating Picture Searches
This L4U Platinum v2.3 and earlier feature has been replaced by Topic Search. L4U 
Enterprise or L4U Platinum Elite users should refer to “Query In Library File” on 
page 116 on how to configure L4U Freedom Topic Searches.

Posting Messages on the iPAC
The equivalent of an electronic message board can be accessed from the iPac. This 
feature allows Administrators and Librarians to post messages for patrons and is ideal 
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for communicating upcoming events, library closures or news updates. If licensed for 
L4U Enterprise, specific locations can have unique messages just for that location

Creating and Editing Messages

1. Other > Messages
2. Select the language to edit the message in and click OK
3. Click Add to Create a New Message or Double Click one of the message head-

ings to Edit.
4. Enter a Topic in the Topic field
5. Enter a Description

• Enterprise users may be able to select the Location this message is applicable
6. Click Done
7. Repeat Steps 4 to 5 for all messages to be entered
8. Click Done

• To edit messages, Repeat Steps 1 - 3. Highlight the text to change and enter 
the new message information

• These new or edited messages will be immediately available for viewing via 
the iPac

To Edit Message Headings

1. Other > Messages
2. Select the language to edit the messages in and click OK
3. Double Click the desired message
4. Click in the Topic Heading to make the changes

• Message headings may be up to 20 characters long
5. Click Done

• The message headings displayed in the iPac will immediately reflect these 
changes

Viewing Messages from the iPac

1. From the iPac home page, click Messages
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2. Click a message heading to display the message
3. Once finished viewing the message, click the Back button on the browser to view 

further messages, or click Home to return to the iPac home page

Creating Web Links
The L4U user has the ability to add Web Links to the iPAC Home page. This means 
that any patron connecting to the library via the Internet will also be provided with 
direct links to other related web sites. These Web Links can be added to and revised as 
necessary. As with Messages, L4U Enterprise administrators can assign specific Web 
Links to certain locations and not others.

Adding a New Site
Once the iPAC Server has been set up, the library administrator can add as many Web 
Links as they choose. Web Links are maintained in the Library Profile, where addi-
tions and deletions can be performed. To add a Web Link to the Web Page:

1. File > Library Profile
2. Click Web Links
3. Click Add Site
4. Enter the Site Name
5. Enter the URL (Universal 

Resource Locator)
6. The URL must include http:// at 

the beginning of the address.
7. Enter a brief Description of the 

web site
8. Click Update

• L4U Enterprise administra-
tors can assign a Location or 
select All Locations as appropriate

9. Click Save
• see “Web Links” on page 54 for information about viewing the links

Federated Search
The L4U iPAC can search different databases in the deep web depending on which 
service the L4U site is licensed for. This licensing and login information is entered in 
Preferences and is supplied by the service provider. Two service providers, EBSCO 
and Encyclopædia Britannica, are supported in Platinum Elite and Enterprise. More 
providers are planned, but this depends on the service providers licensing and market-
ing plans. To enter a service providers licensing/login information:
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1. File > Preferences
2. Click L4U iPac
3. Select the Federated Search tab
4. Click Setup for EBSCO

• EBSCO will be used in this example, other pro-
viders will be similar

5. Enter the information as sup-
plied by EBSCO. For example,
• Login/Profile: also known as 

the Authentication string
• Password: enter the pass-

word as supplied
• Authentication Type: enter 

the information exactly as 
supplied by EBSCO

6. Click Save
7. Click Enable checkbox for 

EBSCO
8. Click Save to close Preferences

Some Service Providers may allow access to only certain databases depending on 
your subscription. To select the default database to search:

1. Reopen Preferences
2. Click L4U iPac
3. Select the Federated Search tab
4. Click Setup

• EBSCO may allow access to only certain depending on your subscription
5. Click Load Databases List
6. Select the desired Default Database to Search from the Default Database Name 

drop down list
7. Click Save to save the edits
8. Click Save to close Preferences

iPAC Customization
L4U gives you the ability to easily customize the look of the iPAC, what features to 
have enabled and how information is displayed. You can create a customized display 
to use as a default for your library in Preferences. This defines the look of the iPAC 
and search results in List View as displayed to all patrons. If licensed for L4U Free-
dom, you can also customize the display for individual Homerooms, see “Creating a 
Customized Search Results Display for a Homeroom” on page 30. In this case, 
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patrons who are not logged in will see the display as specified in Preferences. Once 
patrons log in, the search results will be displayed as specified in their Homeroom.

iPAC Customization - Defaults & Settings

1. Files > Preferences
2. Click L4U iPAC
3. Click iPAC Customiza-

tion
• Freedom Customiza-

tion is discussed on 
page 31.

4. iPAC Customization - 
Settings & Defaults 
screen will appear with 
two tabs:
• General Settings 

which is described 
below

• Search Results Display Customization, “Search Results Display Customiza-
tion” on page 23
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General Settings: Login Defaults

Default iPAC Languages
L4U can display the iPAC screens in one of three Languages; English, French 
or Spanish. The Language selected will affect the buttons and alert messages 
that appear when patrons use the iPAC functions. This setting does not con-
vert the data within your collection, only the interface that displays your 
materials. The Language selection will only apply to the iPAC, and will not 
affect any other levels of L4U. Both the default language display and the lan-
guage used for a specific session can be modified.

Default iPAC Skin
The appearance of the L4U iPAC can be changed by simply selecting a differ-
ent skin. A skin will change the look of the dialog boxes, buttons, etc. of the 
iPAC interface. The different skins available are selectable from the drop list.

Default Location
The different Locations available in L4U Enterprise are selectable from the 
drop list. Locations are created and maintained in the Locations Control File, 
which is covered in more detail on page 78 in the L4U Users Manual.

Default Search Screen
Easy Search will present the iPAC user with one search field to search the 
collection. This may be the best solution for younger patrons. Quick Search 
offers more search options for the patron. Please see “Searching Techniques” 
on page 37.

Initial Screen in iPAC
L4U Freedom administrators have the option to select which screen end users 
will see when the iPAC first opens. Select Login to force patrons to log in to 
use the iPAC. After logging in, the iPAC Customization & Default Settings 
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for their current homeroom will override the global iPAC Customization Set-
tings.

First Screen after Login
L4U Freedom administrators have the option to select which screen the end 
user will see after logging into the iPAC. Home will present the standard 
iPAC search screen and is the preferred option for a typical library patron. 
Select Profile if the end user will use L4U Freedom.

Restrict Easy Search Processing
This setting allows administrators of large districts to lower the CPU load 
when performing concurrent phrase searches in Easy Search results. These 
settings should only be adjusted if directed to do so by L4U Library Software 
Support Department.

Patron’s Customization Settings
Patrons will be able to modify the iPAC Search Results from their web 
browser if enabled. The setting in iPAC Customization & Default Settings for 
their current homeroom will override this setting.

Active Directory Login
If this is enabled, then the patron can also login into the iPAC using their 
Windows network credentials. Please see “Active Directory Integration” on 
page 23 of the L4U Users Manual for more information.

Logout Settings
If a Logout button is required, select the Enabled option. Select an Automatic Time-
out if desired. If 0 (zero) is entered, the automatic timeout will not automatically 
occur.

General Settings: Search Result Settings
These options will allow the librarian to customize the iPAC Search Results to their 
patrons’ needs. When a search is entered in L4U iPAC, the results can be displayed in 
a variety of styles. L4U gives you the ability to easily customize these options. For 
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more information on these options and how they appear in the iPAC, please refer to 
“Viewing Search Results” on page 44.

Default Results Display
• List

This is the basic view of the search results which can be customized. Please 
refer to page 23 for more information.

• Details
This option shows the patron the individual library items in more detail 
including bookcover.

• Biblio
The results list is similar to the Details view but in bibliographic format.

• Bookshelf
This will show your search results in a bookshelf format.

Default Sort
The results list can be sorted in one of three ways. LCN will sort in shelf list 
order, etc. Default Sort direction is in ascending order.

Highlight Search Criteria
This option will highlight the search terms in the resulting lists.

Spell Check Search Criteria
When performing a single field search (i.e.: not Multiseek) and no or few 
results are displayed due to spelling error, L4U will check the spelling based 
on the actual items in the Library file and suggest alternative searches based 
on the correct or alternative spelling.

Perform Similar Searches
If enabled, author searches will display other authors based on the subjects in 
the list of results.
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Display Search Suggestions
When few or no results are returned due to complex multiword searches, L4U 
will list different combinations of the search terms and the number of items 
found using those combinations.

Details Balloons
L4U will present a pop up balloon which contains the item’s bibliographic 
information when the cursor hovers over the title of the item. 

Easy Search on Every Page
The Easy Search button will appear on every page of the iPAC.

Note: To restore the display to the default display settings, click Default

Search Results Display Customization
When a search is entered in L4U iPAC, the search results are displayed in List View. 
The user can then click a link to view an item’s details. L4U gives you the ability to 
easily customize the List View for your library. If licensed for L4U Freedom, the List 
View can be customized for individual homerooms, allowing you to present different 
levels of information to different groups of patrons. Please see “Creating a Custom-
ized Search Results Display for a Homeroom” on page 30 in this chapter for more 
information on Homeroom customization.

Default Search Results Display

Customized Search Results Display for Teachers or a Resource Centre
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To access Search Results Display Customization and set the defaults:

1. File > Preferences
2. Click L4U iPAC
3. Select the Search 

Options tab
4. Click iPAC Customiza-

tion
• Freedom Custom-

ization is discussed 
on page 31.

5. Click Search Results 
Display Customization

6. The steps continue on 
page 25

Selection of Fields to Display
You can choose what columns of information are displayed in List View. This 
allows you to select the fields to be viewed which are of use to your patrons.

Customizing Column Labels
This feature allows you to replace any column labels which may be unfamil-
iar to your patrons with more meaningful labels. You may customize the 
labels in English, French and Spanish. This setting does not convert the data 
within your collection, only the column labels of the search results display.

Adjusting Column Width
How much space is allocated to each column of the display can be easily 
adjusted. Please refer to the screen shot below.

Specifying Page Width
The width of the table returning the search results may be specified as Auto-
matic or Fixed. If Automatic is used, the width of the table displaying the 
search results will be determined by the monitor settings of the patron. In this 
case, the size of the columns is shown as a percentage of the table. Alterna-
tively, you may set the table width to a fixed width of a specified number of 
pixels. In this case, the size of the columns is shown as both a percentage and 
an number of pixels. 

Display Rank in Easy Search
This will display the rank of the hit in the results screen. Please see “Easy 
Search” on page 37 for more information.
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Cont’d from previous page
7. Choose which fields to display from the table under Please select the Columns to 

display from the list below. 
• To add a field to the display, click the field’s check box. 
• To delete a field from the display, click the field’s check box to uncheck it.

8. Change the column label for a 
field by clicking on it and then 
clicking on it again (a slow 
double click). Enter the new 
label for the field
• To modify the labels for a 

different language, change 
the language by clicking on 
one of the three languages’ 
radio buttons under Edit 
Labels for iPAC Language. 

9. Adjust the space allocated to a 
column by pointing the mouse at the divider between two columns in the preview 
area and then click and drag the divider.
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• You may also click the row containing the percentage figures (or number of 
pixels if Page Width Determination has been set to Fixed Width) for the dis-
play, click on a specific number and enter a new value. 

10. Beside Page Width Determination select either Automatic or Fixed Width.
•  If Fixed Width is chosen, enter the number of pixels.

11. Click Save to save the customized iPAC Search Results Display
12. Click Save to save the revised Preferences

Note: To restore the display to the default display settings, click Default

iPAC Customization via Direct Web Page Modification
L4U Web Server is written entirely in HTML utilizing CSS (Cascading Style Sheets), 
enabling the user with the appropriate knowledge to modify their web pages. CSS 
style sheets separate content and design. Historically designers and developers have 
relied upon extensive markup in each individual web page to style their web pages, 
meaning both the design elements as well as the content were included in each page. 
With CSS style sheets the design elements have been taken out of each individual 
page and placed in one file, the.css file, leaving only the content in each web page.

Warning: Do not attempt any customizing unless familiar with HTML program-
ming and Cascading Style Sheets. L4U Library Software will not support 
these pages after they have been customized. Also, ensure the modified files 
are archived to a safe location as the modified files will be replaced when the 
L4U Web folder is replaced during major upgrades.
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Setting Web Privileges
L4U installations that are licensed for L4U Freedom have the added web functionality 
of patron login and various other features such as customization of search results, cir-
culation on the web, editing patron information and viewing patron profiles. Before 
any patron has access to these features they must be activated in the Homeroom file. 
Access settings are controlled in the individual homerooms; therefore, all patrons 
assigned to the same homeroom will have the same access privileges. 

Once the Homeroom Patrons are allowed to log in, a PIN (password) for each Patron 
in the Homeroom should be generated either manually (see “Modifying a Single 
Patron’s Privileges” on page 31), automatically (see “To assign new PINs to the 
Patrons in a Homeroom” on page 30) or manually entered in the Patron record if the 
patron wants to use their own PIN (see “Additional Info” on page 131 of this manual 
for Web Users). After Allow All x Clients in this Homeroom to Login has been 
checked, any new Patrons added to the Homeroom will have a PIN assigned automat-
ically.

To Enable Web Login

1. Functions > Homerooms
2. Double click the Homeroom to mod-

ify
3. Click Login Settings
4. Select Allow All x Clients in this 

Homeroom to Login (x being the 
number of patrons assigned to this 
homeroom)
• This must be enabled to allow 

even one patron in this homeroom 
to login

5. If PIN/Passwords are not assigned, Click the desired Type
6. Check Send an email to notify clients of the new PIN/Password if email notifica-

tion of the change is desired
• Email settings have to configured before email notifications will work. Please 

see “Email” on page 52 of the L4U Users Manual for more information.
7. Click Generate Now to automatically generate passwords

• Delete iPAC Sessions will delete all sessions in this Homeroom. This is useful 
to delete all the bookbags in the homeroom or to purge the L4U cache for this 
Homeroom.

8. Click Save to exit Login Settings, otherwise Cancel to discard any changes
9. Click Save to exit Homeroom Management

Note: Auto Login is described in more detail in “Active Directory Integration” on 
page 23 in the L4U Users Manual.
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To Enable Web Privileges

1. Functions > Homerooms
2. Double click the Home-

room to modify
3. Click Web Privileges
4. Select the specific Web 

Privileges you wish 
these patrons to have. 
These options are 
explained below

Group Login
Enable this feature to allow simultaneous Group or Generic Logins. This allows each 
login to have it's own session and allows for unique bookbags and multiple book rat-
ings. If Group Login is Enabled, then one patron can put multiple ratings on one item 
as long as this patron is doing it from multiple sessions. If Group Login is Disabled, 
then one patron can put only one rating on one item. Please refer to “Group Patrons/
Logins” on page 14 in the Enterprise Administrator Manual for more information.

Renewal/Reserve Options
Enable this option to allow the patron to renew their materials.

• Allow Specific Date Renewal - Allows patrons to assign the due date for cir-
culated materials. If not selected, the due date will be based on the Loan Type 
specifics of the material.

• Allow Overdue Items Renewal - Allows patrons assigned to this homeroom to 
renew their items even if they have overdue items. If not selected, renewals 
for patrons with overdues will be prohibited.

• Show Hidden Items - Materials that belong to Hidden Departments will show 
up in Items Out. The list could be quite extensive if tracking Textbooks, 
which are usually hidden from patron searches.

• Allow Renewal with unpaid Fines - Allows patrons assigned to this home-
room to renew their items even if they have outstanding fines. If not selected, 
circulation to patrons with fines will be prohibited.

• Allow Bookings for any specific period - Allows patrons assigned to this 
homeroom to book materials for any length of time. If not selected, the 
reserve or booking period will be the circulation time associated with that 
item.

• Clients can send Emails - Click to allow patrons to email the bookbag con-
tents.



Chapter 1 Configuring iPac & Freedom

29

Basic Circulation Options
All settings apply to their own circulation unless Allow Circulation for Other Clients 
is selected. These options have no effect on Freedom Circulation.

• Clients can perform Basic Circulation (Circulation Out is enabled) - 
Enabling this option allows patrons assigned to this homeroom to circulate 
items Out to themselves. You can expand on the patrons capabilities by acti-
vating the following options.

• Allow Circulation for Other Clients - Enabling this option allows patrons 
assigned to this homeroom to circulate items out to any patron.

• Allow Circulation In - Allows patrons assigned to this homeroom to check 
items in.

• Allow Circulation with Overdue Items - Allows patrons assigned to this 
homeroom to circulate items out to either themselves or all patrons (depend-
ing upon the options selected) that have overdue items. If not selected, circu-
lation to patrons with overdues will be prohibited.

• Allow Circulation with Unpaid Fines - Allows patrons assigned to this home-
room to circulate items out to either themselves or all patrons (depending 
upon the options selected) that have outstanding fines. If not selected, circula-
tion to patrons with fines will be prohibited.

• Show Client Pictures - If performing circulation while logged on as a patron 
within this homeroom, patron pictures (either their own or other patrons’ 
depending upon the options selected) will display.

• Show Hidden Items in Circulation - All items out, regardless of their depart-
ment status, will display in items out for each patron.

Warning: Do not select Advanced Circulation under Freedom Privileges if limited 
Circulation is required. Selecting Advanced Circulation overrides the Basic 
Circulation settings and allows the Homeroom full circulation privileges. 

To Enable Freedom Privileges

1. Functions > Homerooms
2. Double click the Home-

room to modify
3. Click Web Privileges
4. Click Freedom Privi-

leges
5. Click Allow Clients 

Access to L4U Freedom
6. Select the specific Free-

dom Privileges you wish 
these patrons to have.
• Select Allow Access 

to Advanced Circula-
tion if you wish the patrons to have access to full circulation functionality. 
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7. Click Save to save the Freedom Privileges settings

To assign new PINs to the Patrons in a Homeroom
PINs are automatically assigned when new Patrons are entered. You can override the 
automatically generated PIN when you enter the new Patron or you can generate new 
PINs for all patrons in a Homeroom:

1. Functions > Homerooms
2. Double click the Homeroom to modify
3. Click Login Settings
4. From the drop down list, select the Length of PIN to use
5. Select the Type of PIN you wish to assign
6. If all patron records contain a valid email address, check Send an email to notify 

clients of the new PIN/Password
7. Click Generate Now
8. If any of the patrons already have PINs assigned, a confirmation screen appears. 

Click Overwrite PINs or Skip these clients
9. A confirmation appears, click OK
10. An alert appears confirming the number of PINs assigned. Click OK
11. Click Save
12. Click Save to save the Homeroom

Note: If you are not satisfied with the automatically generated PIN/Passwords or 
you want your patrons to choose their own, you can modify the patron 
records individually. However, Web access must be enabled in homerooms.

Creating a Customized Search Results Display for a Homeroom
If licensed for L4U Freedom, you can customize the search results display for indi-
vidual homerooms, allowing you to present different levels of detail for different 
groups of patrons. This version of the List View will be displayed to the patron after 
they have logged in and will override the global iPAC Search Results display setting 
in Preferences. This is true for any Freedom Customization changes made in the 
homeroom. The version of the List View for the Library File or Reserves will be dis-
played to the patron when they view the respective Freedom pages and will override 
the settings in Preferences. To customize the Search Results display for a specific 
homeroom:

1. Functions > Homerooms
2. Double click the Homeroom to 

modify
3. Click iPAC Customization or 

Freedom Customization as 
required. 

4. Make the required changes to the 
Search Results Display
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• These options are described in “Search Results Display Customization” on 
page 23 of this chapter.

5. Click Save to return to Homeroom Management
6. Click Save to save your changes

Warning: You must click Save on the Homeroom Management screen in order to 
save the changes you made to Web Customization.

Modifying a Single Patron’s Privileges
You may find that you wish to remove a patron’s login access or perhaps only allow 
access to a few patrons within a single homeroom. In order for even one patron within 
a specific homeroom to have access to login, the homeroom must have the Web Login 
enabled, see “To Enable Web Login” on page 27. It is not possible to enable only cer-
tain privileges for certain patrons within the same homeroom. If you want only a few 
patrons within a homeroom to have login capability, enable Freedom privileges but 
delete the PINs for the individual patron records. Once the homeroom has been set up, 
you can modify the patrons who do not have login privileges. To modify a single 
patron’s Freedom privileges:

1. Functions > Clients
2. Locate and Double click the patron to modify
3. Click the Additional Info tab
4. Make the required change in the PIN field

• Delete existing PIN to stop access to Freedom login
• Enter the requested or preferred PIN to allow access to Freedom login

5. Click Save

Freedom Customization
L4U gives you the ability to easily customize how the information is displayed in 
Freedom. You can create a customized display to use as a default for your library in 
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Preferences. This defines the look of Freedom and search results in List View as dis-
played to Freedom users. You can customize the display for individual Homerooms, 
see “Creating a Customized Search Results Display for a Homeroom” on page 30. 
Patrons in a homeroom will see the customization as configured in Preferences if their 
Homeroom’s Customization hasn’t been defined. In other words, they will see the dis-
play as specified in Preferences. Once patrons log in, the Freedom customization will 
be displayed as specified in their Homeroom.

Freedom Customization

1. Files > Preferences
2. Click Freedom Cus-

tomization
3. The Freedom Cus-

tomization screen will 
appear with a drop-
down menu. The 
options are:
• Library File 
• Reserves

4. This allows custom-
ization for the these 
Freedom screens

5. After customizing the 
appropriate Freedom Screen, Click Save

Configuring these Freedom options is the same as configuring the iPAC Search 
Results screens. Please refer to “Search Results Display Customization” on page 23 
for more information.
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Note: After saving your edits, log out of Freedom and then back in to see your 
changes.
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Accessing the Internet Public Access Catalog (iPAC)
The iPAC (Internet Public Access Catalog) is the interface that patrons use to access 
the library collection. Patrons can search, view details, sort result lists, print bibliogra-
phies and create bookbags. If licensed for L4U Freedom and using My Profile, 
patrons may also place Reserves, Renew & Circulate materials. Please see “L4U On 
The Web” on page 64 for more information on My Profile.

Additional administrative features are available via the L4U Freedom Profile. These 
include cataloging (Acquisitions), Advanced (Full) Circulation, Client Management, 
Inventory, Specific Reports and Labels. This allows libraries to use any internet 
browser equipped computer as another administration station. Please see “Freedom 
Profile” on page 67 for more information on My Freedom Profile.

These extra features are enabled and controlled through Web Privileges set in Home-
rooms. More information can be found in “Setting Web Privileges” on page 27. 

Accessing iPAC
For more information on how to access the iPAC, please refer to “iPAC Connection 
Types” on page 3.

Navigating the iPAC
The iPAC has the identical appearance whether it is the internal iPAC or on a web 
browser. Unless your installation has been customized by your own technicians, the 
first page that displays for the iPAC is the home page. From the home page you have 
several options for moving between search types and a number of static links that 
appear on the toolbar.
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Some links and options may not appear on your screen depending upon your licens-
ing. For Example: Wide Area Searching drop down list, Log In, Location drop down, 
etc.

iPAC Toolbar
The iPAC toolbar remains consistent throughout all iPAC pages and appears at both 
the top and bottom of the page. To access the specific search types or links, simply 
click the preferred option.

Searching Techniques
L4U offers several ways for clients to search the Library collection, ranging from 
Easy Search or Quicksearch, to a complex multi-level search. Access to the more 
complex searches can be restricted by employing a modified iPAC skin. The Picture 
Search, Multiseek and Advanced searches are accessed through the toolbar or from 
the menu on the left of the homepage. On the standard iPAC skin, either Easy Search 
or Quicksearch is the default displayed on the homepage. Which search screen dis-
plays depends on the iPAC Customization Settings. The default settings are config-
ured in Preferences (please refer to “Default Search Screen” on page 20) or can be 
configured on the fly from within the Internet Browser (please refer to “Viewing 
Search Results” on page 44).

Easy Search
The Easy Search was introduced for patrons who are not exactly sure of how to 
phrase a query, but have a good idea of what they are looking for. Easy Search uses 
search techniques similar to the popular internet search engines. The most popular 
fields in L4U (e.g. title, author, subtitle, series, etc.) are searched and assigned a 
weighted value. The resulting list is then sorted on the total weighted value. For more 

Toolbar at top of each page

Toolbar at bottom of each page
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information on how to change the weighting scale, please contact L4U Technical Ser-
vices. To use Easy Search:

1. On the iPAC homepage, Type in the search criteria in the field provided
• This can be a single word, multiple words or a phrase

2. Click the magnifying glass icon
• Pressing ENTER on the keyboard will perform the search as well

3. The iPAC displays a list of items that match the search criteria

Quicksearch
This search is the simplest of all the searches and will likely be the most used by your 
patrons. The search criteria entered for this type of search can be a single entry, multi-
ple words or a phrase. Exactly how the search is executed will depend upon the search 
options selected in Preferences, see “Combining Search Terms” on page 14. To use 
Quicksearch: 

1. On the iPAC homepage, Type in the search criteria in the field provided
• This can be a single word, multiple words or a phrase
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2. Click the icon that represents the type of search to perform
• Pressing ENTER on the keyboard performs a Keyword search

3. The iPAC displays a list of items that match the search criteria

Note: Searches are not case sensitive and do not recognize articles (the, and, a, etc.). 
Quicksearch & Authority Quicksearches work exclusively with keywords 
and not all words are keyworded. For more information on excluded key-
words, see page 36 in the L4U Users Manual.

Keyword
The keyword search is performed by entering the search criteria and either 
pressing the ENTER key on the keyboard or by clicking the Keyword icon. 
When this option is selected, L4U searches the keywords of each item record 
looking for a match to the search criteria. Keywords are derived from various 
fields within the item record. For more information on keywords, see “Key-
words” on page 35 in the L4U Users Manual. Additionally, L4U applies the 
search option selected in Preferences when performing a keyword search. 
There are two search options that effect how the search is conducted. The 
comparison value between multiple words entered can be set to AND or OR. 
Selecting OR will return results that contain any of the words entered 
whereas, selecting AND will return results that contain all of the words 
entered. To adjust this setting, “Combining Search Terms” on page 14. Using 
keywords results in a greater hit rate than using a single search category.

SoundsLike
The SoundsLike search is a phonetic search tool. It is especially useful for 
those hard to spell terms and patrons who experience difficulty with spelling. 
To use the SoundsLike search, Enter the word as it sounds phonetically and 
then click SoundsLike. For Example: Entering elifant will produce those 
records with a keyword of ‘Elephant’. L4U searches a list of phonetic key-
words that has been generated from the item keywords.

Authority Quicksearches
Authorities have their own keywords and these keywords are searched when using the 
following functions. Authority keywords are created from the respective Authorities 
and use the same Keyword Exclusion list in Preferences. For more information on 
excluded keywords, see page 36 in the L4U Users Manual.

Subjects
To search for a Subject, Enter the Subject or a portion of the Subject and click 
Subject. For Example: plan would produce records with Subjects such as 
‘Plants’, ‘Trips--Planning’ or ‘Planets’. Enter a complete term for more exact 
searching. If multiple search criteria has been entered, L4U will apply the 
Authority Keyword Searches preference setting and look for matching items 
in the Subjects keywords table.
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Title
To search for a Title, Enter the Title, or a portion of the Title excluding all 
articles (The, An, A, etc.) and then click Title. Example: enter cat and the 
results will include items such as ‘Cat in the Hat, The’, ‘To catch a mocking 
bird’ and ‘Catcher in the Rye’. Enter a complete term for more exact search-
ing. If multiple search criteria has been entered, L4U will apply the Authority 
Keyword Searches preference setting and look for matching items in the Title 
keywords table. If an exact match is desired, please use the Advanced search. 
The Advanced Search doesn’t use keywords and looks at the complete title in 
the Library File.

Author
To search for an Author’s name, Enter the search criteria and click Author. 
The name does not have to be entered completely or in direct order. For 
example: Entering alex smith can produce a result of ‘Smith, Alexander’. If 
multiple search criteria has been entered, L4U will apply the Authority Key-
word Searches preference setting and look for matching items in the Author 
keywords table.

Series
To search for a Series, Enter the Series or a portion of the Series and click 
Series. For Example: read would produce results such as ‘Reading rainbow’ 
or ‘Step into reading’. Enter a complete term for more exact searching. If 
multiple search criteria has been entered, L4U will apply the Authority Key-
word Searches preference setting and look for matching items in the Series 
keywords table.

Editor Illustrator
The Editor/Illus search applies the same method as the Author search. To 
search the Editor/Illustrator field, Enter the search criteria and click Editor 
Illustrator.

Topic Search
Topic Searches are predefined searches that are executed by clicking on graphics dis-
played in the iPAC. Topic Searches are configured by the Librarian and allow quick 
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access to relevant materials in the collection. Please see for more information on how 
to setup and configure Topic Searches. To execute a Topic Search:

1. On the iPAC homepage, click Topic Search
2. The Topic Search Carousel appears.

• Click the Curved Arrows to move through the list of topics.
• Click the Play button to start the Carousel
• Click the Pause icon to stop the Carousel

3. Click on the appropriate Search icon

• A submenu may appear with more search icons or
• A list of search results is displayed
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Picture Search
For L4U Platinum Users
Picture Searches have been replaced by Topic Searches in L4U Platinum Elite. Please 
refer to “Topic Search” on page 40 on how to use L4U Freedom Topic Searches.

MultiSeek
The Multi Seek option provides the client with the ability to search on multiple topics 
at one time. Boolean operators combine terms for more streamlined results. To per-
form a MultiSeek search:

1. On the iPAC homepage, click MultiSeek on the toolbar or the menu
2. From the drop down menus on the left, Select the field(s) to search
3. In the field(s) provided, 

Enter the search criteria
4. From the drop down 

menus, Select the Bool-
ean search operand
• OR - used to receive 

search results that 
contain either of the 
items before and after 
the OR operand. 
Example: Selecting 
‘cat OR dog’ will pro-
duce results that con-
tain both cat and dog, 
as well as only dog or 
only cat.

• AND - will produce 
results that contain both items before and after the AND operand. Example: 
Selecting ‘mouse AND elephant’ will only produce results that contain both 
mouse and elephant.

• NOT - will produce results that contain the item(s) before the NOT operand 
but excludes items after the NOT operand. Example: selecting ‘cat NOT ele-
phant’ will produce results that contain cat, but will exclude items which con-
tain cat as well as elephant.

5. Media and/or Level can be used in conjunction with the MultiSeek search crite-
ria.
•  If Media and/or Level are used, their Boolean search operand is always AND 

with respect to the other criteria specified.
6. Click Search

• Reset will reset the search to default so that a new search can be entered
7. The Results screen will display the number of hits in the Title Bar and list them in 

the main screen.
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Note: Very specific searches yield a much smaller hit rate. To broaden searches, use 
the OR operand.

Advanced Search
The Advanced Search feature searches the fields of an item record directly as opposed 
to searching the keywords associated with the field. This means that users will have to 
enter more specific search criteria. This search is conducted in a direct, or left to right, 
order. For Example: entering cat would result in hits such as ‘Cats and Dogs’ or ‘Cat-
erpillars’ but it will not find ‘Arthur catches a train’. This search type also includes 
the ability to do between searches for finding ranges of items. For Example: items 
with Deweys from 001 to 010. To use the Advanced search:

1. On the iPAC homepage, click Advanced from the toolbar or the menu
2. Select the field to search
3. In the first field provided, Enter the search criteria

• To search for the criteria exactly as typed, type a ‘.’ after the entry. Example: 
cats.

4. Click Search

Between Searching
Between search can be 
enabled to perform 
searches for items in a 
range. This could be items 
between a certain range of 
dewey designations or 
items entered into the col-
lection between specific 
dates. To perform a 
between search using 
Advanced:

1. On the iPAC homep-
age, click Advanced
• From the toolbar 

or the menu
2. Select the field to search
3. In the first field provided, Enter the ‘from’ search criteria
4. Click the Enable Between Searching checkbox
5. Enter the ‘to’ value in the second field
6. Click Search

Note: To clear the field selected and the value(s) entered, click Reset.
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Viewing Search Results
By default the iPAC local collection search results are displayed in Detail view. By 
default this list includes the Title, Subtitle, Author, Publisher, Call Number, Status, 
Location, Book Cover and lists each individual item separately. This initial listing of 
found items can also be displayed as Authorities (Authorities display is available for 
List, Details & Bibliographic views). To change from Authority or Items display or 
set a default, see “Authority vs. Item Display” on page 11.

Items Display (Details View) Authority Display

Note: If L4U is set to Item display and you have performed a Quicksearch on one of 
the Authorities (Title, Author, Subject, Series, Editor Illustrator), you can 
switch to the Authority view by clicking the link at the bottom of the page. In 
the case of a Subject search the link will read, Display by Subject.

The Authority display is a table containing only a list of hits and the number of items 
associated to each. For Example: a Title search would result in a list of Titles only and 
the number of items containing the search term in that Title. To view the individual 
items, you must click the Title link.

More tabs will appear at the top of the results list if licensed for Federated Searching 
and the Service Providers login credentials have been configured in Preferences. 
Please refer to “Federated Searches” on page 52 for more information on how to use 
Federated Search.

Regardless of the view chosen, the total results are listed at the top of the table and the 
records are displayed 15 per page. To view the next 15 records, simply Click Next 15 
Hits or the preceding records, Click Previous 15 Hits.
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Search Results Options
Search results can be further refined with the following options. These options can be 
set in Preferences to be the default when a new internet browser window is opened or 
modified on the fly in the current internet browser window (current session). The cur-
rent session settings override the settings defined in Preferences. To modify the Cur-
rent Session iPAC Customization Settings:

1. From any iPAC page, hover the mouse 
pointer over the cog icon

2. Select the desired option

OR

1. From any iPAC page, click the cog icon
2. Select the desired options
3. Click Apply

The settings are then applied to the current ses-
sion. If the window is closed, these options will 
be lost and any new internet browser sessions 
will use the settings in Preferences.

Default Results Display

List
This view is similar to the list of 
materials as presented in the 
Library File and other files in 
L4U. This view presents the 
most items on the screen with 
the minimum amount of space.

Details
Detail display shows the patron 
the individual library items in 
more detail than the List results.

Bibliographic
The results list is similar to the 
Details view but in bibliographic 
format.
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Highlight Search Criteria
This option will highlight the 
search terms in the resulting lists. 
This allows patrons to quickly 
locate the relevant items on 
screen.

Spell Check Search Criteria
When performing a single field 
search (i.e.: not Multiseek), L4U 
will check the spelling of the 
search terms and suggest alterna-
tive forms of the misspelled 
words from the collection’s keywords. For example, a keyword search of aro-
ara boreealis will result in L4U suggesting aurora borealis.

Perform Similar Searches
If enabled, author searches will 
display other authors based on 
the subjects in the list of results. 
For example, a search for the 
author Anna Sewell, will list 
these authors because of the sub-
jects associated with Anna 
Sewell’s found materials.

Display Search Suggestions
L4U will list different combina-
tions of the search terms and the 
number of items found using 
those combinations. For exam-
ple, a keyword search of civil 
war videos is too specific and 
returns no hits. L4U will suggest 
alternative search terms with the 
number of items associated with that search term.
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Details Balloons
L4U will present a pop up bal-
loon which contains the item’s 
bibliographic information when 
the cursor hovers over the title of 
the item. To dismiss the balloon, 
either click the close box or click 
on another item’s title.

Easy Search on Every Page
The Easy Search button can be displayed on every page of the iPAC.

Default Search Screen
Easy Search will present the iPAC user with one search field to search the 
collection. This may be the best solution for younger patrons. Quick Search 
offers more search options for the patron. Please see “Searching Techniques” 
on page 37.

Default iPAC Languages
L4U can display the iPAC screens in one of three Languages; English, French 
or Spanish. The Language selected will affect the buttons and alert messages 
that appear when clients use the iPAC functions. This setting does not convert 
the data within your collection, only the interface that displays your materials. 
The Language selection will only apply to the iPAC, and will not affect any 
other levels of L4U. Both the default language display and the language used 
for a specific session can be modified.

Default iPAC Skin
The appearance of the L4U iPAC can be changed by simply selecting a differ-
ent skin. A skin will change the look of the dialog boxes, buttons, etc. of the 
iPAC interface. The different skins available are selectable from the drop list.
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Navigating the Results List
Standard internet browser window controls are available when the display is set to 
Item Display. Sort by, Records per Page and Go To a desired page allow patrons to 
quickly navigate the results list.

Sorting Search Results
While in the Item or 
Authority list views, it is 
possible to sort the search 
results. This is achieved 
by clicking the column 
label by which you wish 
to order the records. 
Clicking the column label 
once will sort the records 
in ascending order. If you 
click the same label 
again, the records will be 
listed in descending 
order. If you reorder a list while viewing any page other than the first results page, 
you will be returned to the first page with the new sort order displayed.
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Viewing Item Detail
Once you have performed a 
search and have a list of results, 
you may wish to view the 
records in more detail. This is 
done by clicking the Title link of 
the item you wish to view. When 
using the Authority view, you 
will need to display the individ-
ual records by clicking the link 
in the authority list prior to 
selecting an individual record.

The item detail display contains 
all the information specific to the 
item chosen. This can include: 
Title, Subtitle, Author, Local 
Call Number, Status, Pages, Publishing information, Circulation (Loan period) infor-
mation, Department, Media, Subjects and Description. Any data entered in the library 
file record will be displayed in the iPAC item detail. If a book cover has been saved to 
this item record, it will display as well.

Note: While viewing the details of a specific record you can return to the search 
results list by clicking Go Back.

Book Ratings
L4U allows for patron ratings of books and other library materials. It is based on a 
five star system, with one being low and five being the highest rating. L4U will aver-
age the rating based on the number of ratings received. The patron has to login to the 
iPAC to rate materials. Also, the Library Administrator has to enable Show Item Rat-
ings in Preferences. To rate an item:

1. Locate the item to be rated using one 
of the Search options

2. Open the item
3. Click Rate this Item
4. Click on the desired rating
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5. The Item Detail screen is displayed with the current averaged rating.

Note: Only one rating is allowed per patron unless Group Login is enabled for the 
logged in patron’s Homeroom. Please refer to “Group Login” on page 28.

Social Network Links
If enabled by the librarian, social networking links are available so library patrons can 
like and share their favorite books with friends via Facebook, Twitter, My Space and 
other popular sites. School district policies may block access to some of the sites or 
features.

Related Searches
When viewing the item details for an individual record, a related search can be con-
ducted by clicking any field data that appears as a link. These fields will most often be 
Title, Author, Series, Ed/Illus and/or Subjects. By clicking one of these links a page 
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will display showing that search criteria and the number of records that contain the 
selected information. Clicking in this list will display the individual records.

View MARC Record
Within the item detail view is a View MARC Record link. This link is used to view the 
MARC tagged display of the chosen record. This option is useful for using alternate 
L4U collections as a cataloging source. The process is similar to the Internet down-
load described in “Import Tab” on page 103 in the L4U Users Manual, with the 
exception that your MARC record source is an L4U iPAC as opposed to the Library 
of Congress. To view the MARC record in tagged display, simply click the View 
MARC Record link in the item detail view of the chosen record.

Resources
If additional resources have been identified in the item’s record, they will be dis-
played as links opposite the heading Resources. Additional resources may be pictures, 
music or other types of files and links to other internet pages. To access the resource, 
click on the link.

eBooks Common Area
L4U Enterprise allows the District Librarian to create a Common Area 
for the repository of eBooks. All materials assigned to this Common 
Area will appear in all iPAC searches regardless of their current loca-
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tion and show up in iPAC search results with a special icon. Physical and electronic 
resources are easily integrated in the same collection.

Federated Searches
Federated Searches can be best described as a simultaneous search of the local collec-
tion(s) and a remote database(s). Search results are then displayed in the iPAC as sep-
arate tabs. The L4U iPAC can perform Federated Searches if licensed for L4U 
Freedom. Searching remote databases is available if your site is licensed to search 
these content providers. The individual Content Providers login credentials have to be 
configured in Preferences before the Federated Searches will work. Please refer to 
“Federated Search” on page 17 for more information on Configuring Federated 
Searches.

Please refer to the Content Provider’s documentation or their online help for more 
information on their sites features.
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To use Federated Searching

1. Login to iPAC, see page 64
2. Perform a Quick Search (keyword) or an Easy Search, see page 37

• Federated Search only works with these search methods
3. In addition to the search results from the local collection(s), tabs will allow 

browsing of the content as provided by the other sites
• Only the first 25 hits are listed in the iPAC results based on their relevance as 

determined by the Content Provider
4. Click on the Title or Click the Go Directly to Search Provider Interface for 

Search Results link for more information on the item
• The Search Providers web page will open in a separate window and may 

require a secondary username/password to proceed
5. If the search provider allows search-

ing of specific databases, make the 
desired choice from the Select Data-
base drop down

Messages
Library patrons can access a message area from any page 
of the iPAC. To view messages: 

1. On any iPAC page, click Messages on either the top 
or bottom toolbar

2. Select a Message Category.
• Only categories that have messages will appear as 

a link.
3. The message will appear.
4. To exit the message screen, either click the browser 

Back button or Home on the toolbar

New Items

The iPAC contains a New Items link that can be used to display a list of items recently 
added to the collection. The number of days an item stays ‘new’ is determined by a 
Preference setting (see “New Items Search Options” on page 12) and the Entry/Issue 
field within each record. To access New Items:
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1. On any iPAC page, click New Items on either the top or bottom toolbar
2. A page appears listing all items that are classified as new
3. To exit New Items, click Home

Web Links
The library administrator has the ability to add customized Web Links to the iPAC. 
Any patron connecting to the library via the internet will also be provided with direct 
links to other web sites (as set up by the Library Administrator). These Web Links can 
be added to and revised as necessary. Web Links are maintained in the Library Pro-
file. To add a Web Link to the Web Page, see “Creating Web Links” on page 17.

Viewing Web Links
Web Links are an excellent tool for directing patrons to areas of interest on the Inter-
net. If a school or school district web page has been established, this is where a link 
can be set up. To view existing Web Links:

1. On the iPAC home page, click Links on either the top or bottom toolbar
2. To access a listed site, click the Link
3. To exit web links, click Home
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Working with Bookbags
The L4U iPAC includes a Bookbag feature. The Bookbag is used to group items of 
interest that are not necessarily accessed from the same search and then display all 
selected items as one list. Bookbags are local to the browser therefore, individuals on 
separate computers can be working with their own bookbags simultaneously.

Adding Items to the Bookbag
Multiple items can be added to the Bookbag throughout an iPAC session. The items 
are saved in the Bookbag until they are cleared or a new iPAC session is started. To 
add items to the Bookbag:

1. While in the iPAC, Con-
duct a search

2. From the results list, 
Select items of interest 
by clicking the check 
box to the left of the 
record.

3. Click Add to Bookbag
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• If items already exist in the Bookbag this button will read Update Bookbag
4. A count of items 

in the Bookbag 
will appear on 
screen and under 
the task bar

Note: The Bookbag 
link will only 
appear under 
the task bar if 
it is currently 
in use. Once a 
bookbag is 
emptied, the link will no longer appear.

Adding to the Bookbag from Item Details
Adding multiple items to a bookbag from the list view is quick and easy; 
however, you may also wish to view the details of an item before adding it to 
the bookbag. You can add an item to the bookbag while viewing the chosen 
record’s details. Simply view the record detail and click the Add to Bookbag 
button. The button changes to red and reads Remove from Bookbag. To 
remove from the Bookbag, click the Remove from Bookbag button.
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Viewing Items in the Bookbag
The Bookbag contents can be viewed at any time. Display the Bookbag by clicking 
either the Display Bookbag button available from the search results screen or the 
Bookbag link under the toolbar from any screen.

Deleting Items from the Bookbag
Individual items can be removed from a Bookbag without clearing its entire contents. 
To remove an item from the Bookbag:

1. Click Display Bookbag or the Bookbag link
2. Deselect the check box of the item to be removed
3. Click Update Bookbag

Removing an Item from Detail View
A single item or multiple items can be removed from a bookbag while in the 
bookbag view. You may wish to review the items one by one before deleting 
them from the bookbag. 

To review an item and then remove it:

1. Click Display Bookbag or the Bookbag link
2. Click the title link of the record to review
3. In the detail view, click Remove from Bookbag
4. Click Go Back

• You are returned to the next Items Detail view

Emptying the Bookbag
Once you are finished with a Bookbag, it can be deleted from the iPAC station. To 
remove an entire Bookbag, simply click the Empty Bookbag button (displayed in the 
search results screen). If the Empty Bookbag button is not available, first click the 
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Bookbag link under the task bar to display the Bookbag contents and then click Empty 
Bookbag.

iPAC Voting
All voting in L4U takes 
place in the iPAC. Elec-
tions are set up and 
monitored from the 
Administration area of 
the program; however, 
individuals cast a vote 
from the iPAC stations. 
When there are active 
elections taking place, a 
Vote Now link appears 
on the home page.
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Casting a Vote
Voting takes place on the web client (iPAC). Depending on whether it is a free or 
restricted vote, all or only specific clients will be able to cast a vote.

To cast a vote:

1. On the iPAC Home page, 
click Vote Now

2. From the drop down list, 
Select the desired choice
• If more than one election 

is active, each election 
will display on a sepa-
rate line with a drop 
down list of candidates

3. Click Vote!
• A confirmation screen 

appears. If the results are 
set to display During the 
Election, a to-date tally of votes will be listed
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4. If the vote is restricted, reg-
istration is required. Enter 
the client code and pass-
word (PIN)

5. Click Login
• A confirmation screen 

appears. If the results are 
set to display During the 
Election, a to-date tally 
of votes will be listed.

6. To continue with searching, 
click Home

Note: If concurrent elections 
are both free and restricted votes, each election will have a separate Vote but-
ton. However, if all elections are either free or restricted, the patron can make 
a selection for all elections and click vote once.

Election Results
Once all votes have been cast 
and the election is complete, the 
results can be viewed and 
printed from the iPAC screen by 
clicking the Election Results 
link on the home page.
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The election results can also be printed from an administration station with access to 
Preferences. The report is generated from the Election Management screen.

1. File > Preferences
2. Click L4U iPAC
3. On the Configuration & Startup tab, click Update Voting
4. Highlight the election to report
5. Click Subset
6. Click Print
7. On the Reports tab, click Custom
8. Use the Report Editor to create a report with the required information

• See “Custom Report Editor” on page 233 in the L4U Users Manual for more 
information on using the Report Editor
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CHAPTER 3
WEB ADMINISTRATION

iPAC and Freedom Login to L4U on the Web

My Profile and Freedom Profile

My Items Out & Renewals

Reserves

Sending Bookbags by Email

My History

Basic or Limited Circulation

Circulation Period Hierarchy

Log out of L4U on the Web

Quit iPAC



L4U Web Manuall

64

L4U On The Web
Everything discussed in the iPAC chapter is available to all L4U Freedom licensed 
users. After a patron logs in and using My Profile, they may place reserves, renew & 
circulate materials. Additional administrative features include Freedom Circulation, 
Client Management, Inventory, Online Reports, EZ Labels and Online Cataloging via 
My Freedom Profile. This allows libraries to use any internet browser equipped com-
puter as another administration station. These extra features are enabled and con-
trolled through Web Privileges set in Homerooms which is covered in more detail in 
“Setting Web Privileges” on page 27.

iPAC Login
If licensed for L4U Freedom, patrons must login to the iPAC in order to access My 
Profile or My Freedom Profile. Login is accomplished by entering a patron code and 
PIN/Password. Authorized patrons can have access to their circulation histories, 
reserves, renewals or other information depending on privileges assigned by the 
Library Administrator. Please see “Setting Web Privileges” on page 27 for more 
information on assigning Web Privileges. To login to My Profile:

1. From the iPAC 
home page, click 
Login under the 
toolbar

2. Do one of the fol-
lowing
• Enter your Cli-

ent Code
• Enter your last 

name
3. Enter your PIN/

Password
• The PIN/Pass-

word is not case 
sensitive

4. Click Login

Note: Your Windows login credentials may also be used if Active Directory Login 
is enabled. This is usually administered by the L4U Application Specialist or 
District Librarian. For more information, please see “iPAC Login using 
Active Directory” on page 24 in the L4U Users Manual.
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My Profile
Once logged in, L4U users are presented with the My Profile or the Freedom Profile 
page. The features available are divided into two categories: tasks specific to the user 
currently logged in or Administrative tasks which the user currently logged in can 
perform for themselves or other users.

Patron centric tasks 
available are Reserves, 
Renewals, Bookbags, 
Fines and Fines Histo-
ries, Histories & Basic 
Circulation.

Administrative tasks 
available are Freedom 
Circulation, Client 
Management, Acquisi-
tions and Inventory and 
can be accessed via the 
L4U Freedom button.

The Library Adminis-
trator controls what 
options are available in 
My Profile. Only those 
features that have been 
enabled in Preferences 
and via the Homeroom 
Freedom Privileges set-
tings will display here. For Example: Reserves or Renewal will only appear for those 
patrons that have this type of access.

My Profile outlines the details of the patron and their circulation activity. To view the 
items currently on loan, overdue or on reserve, click the appropriate tab for more 
detail.

If licensed for L4U 
Enterprise, select the 
location to be used in 
iPAC searches, if 
available.
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L4U Freedom Login
In order to access the L4U Freedom features, users must login to My Profile first, see 
“iPAC Login” on page 64. To login to Freedom:

1. From the My Profile page, click L4U Freedom 
2. The L4U Freedom Profile appears

Note: Forced login enabled by the library administrator means all iPAC users have 
to login to access the iPAC features.
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Freedom Profile

The Freedom Profile page has the Freedom Toolbar which allows quick access to the 
various functions.

The icons are, from left to right:
Freedom Home: Returns to the My Freedom Profile home page.
Circulation: Please see “L4U Freedom Circulation” on page 136.
Client Management: Please see “Freedom Client Management” on page 128.
Library File: Please see “Modifying the Library File” on page 106.
Reserves: Please see “Placing Reserves” on page 158.
Reports: Please see “Online Reports in L4U Freedom” on page 170.
Acquisitions: Please see “Freedom Acquisitions” on page 80.

 iPAC: Returns to My Profile.

Freedom Dashboard
Once in one of the Freedom Functions, the Freedom Dash-
board is available to navigate to a previous or next record as 
well as to Save your edits or to Cancel to discard your edits. 
Use the Freedom Dashboard navigation buttons (ie: Save, 
Next, Previous, Cancel, etc) and not the Internet Browser 
Forward and Back buttons.
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My Items Out & Renewals
Items currently out can be viewed by 
either of the following methods:

• My Profile page. The logged 
in patron’s items are listed 
under the Items Out tab. 

• My L4U Freedom Profile 
page. Enter a patron in the 
Basic or Freedom Circulation 
and their items will be listed.

The page illustrated will display all 
items currently out to the patron 
including overdue items listed in red. 
Items can be viewed and renewed 
from this page.

To Renew Items via My Profile
From the My Profile screen, you can renew an item or all items currently checked out 
to you. Whether the renewal process includes overdue items or items renewed until a 
specific date depends upon the iPAC privilege settings assigned to your homeroom, 
see “Setting Web Privileges” on page 27. To renew items from Circulation in L4U 
Freedom, please refer see “Renew Items” on page 145.

Renew Selected Items
Patrons can renew specific items. First they must login to the iPAC, then view their 
current items out. To renew only specific items:

1. From My Profile screen, click 
Renewals

2. The Web Renewal Wizard is dis-
played

3. Check the items to be renewed
4. If required, Check the Renew 

Overdue Items option
5. If a specific date is required, Enter 

the date by typing in the field pro-
vided or by using the pop up cal-
endar.

6. Click Renew Selected Items
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7. Step 2 of the Web Renewal 
Wizard is displayed detailing 
whether or not items can be 
renewed and for what dates. 
Click Renew
• If you wish to make 

changes, click the Back 
button

8. Step 3 of the Web Renewal 
Wizard appears with the new 
due dates(s), click Return to 
Renewals to continue

Renew All Items
In addition to the ability to perform renewals on specific items, patrons can renew all 
items currently checked out to them. The ability to renew overdue items or request 
renewals for a specific date is controlled by a setting in Homeroom Web Privileges. 
To renew all items:

1. From a My Profile screen, click 
Renewals

2. Step 1 of the Web Renewal Wizard 
appears

3. If required, Check the Renew Overdue 
Items option

4. If a specific date is required, Enter the 
date by typing in the field provided or 
by using the pop up calendar

5. Click Renew All Items
6. Step 2 of the Web Renewal Wizard 

appears detailing whether or not items 
can be renewed and for what dates. 
Click Renew
• If you wish to make changes, click the Back button

7. Step 3 of the Web Renewal Wizard appears with the new due dates, click Return 
to Renewals to continue

Note: Any fines that are accumulating for overdue items will be listed under the 
Fines column beside the item that has accrued the fine.
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Reserves
With L4U Freedom, patrons can place reserves via the web. Reserves can be placed 
via My Profile or from Advanced Circulation. This option is controlled through a 
Preference setting and the Homeroom Freedom privileges and can be enabled or dis-
abled by the library administrator. Reserves can be placed on individual items from 
item detail view or multiple reserves can be placed on an entire bookbag.

Placing a Reserve from item detail view

1. While logged into the iPAC, search for the desired item and click the Title for 
details

2. Click Place a Reserve
3. Enter an optional Requested For date or use the pop up calendar
4. Enter an optional Requested Until date or use the pop up calendar
5. Click Place Reserve

• A screen confirming the reservation will display.

Reserves on a Bookbag
Reserves can be placed on multiple items at one time. This is done by first collecting 
items into a bookbag. Please see “Working with Bookbags” on page 55 for more 
information on using a bookbag. To place a reserve on items in a bookbag:

1. While logged into the iPAC, search for the desired items and create a bookbag
2. Click Bookbag under the top toolbar
3. Click Place a Reserve on Current Bookbag below the Bookbag display area
4. Click Place a Reserve
5. Do one of the following:

• Select the checkboxes beside the items to reserve and click Reserve Selected 
Items

• Click Reserve All Items
6. The next page displays a listing of all reserves
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Deleting iPAC Reserves
Once a reserve has been placed, patrons can view and delete reserves from the web. 
To view their reserves a patron first must log in to the iPAC. Once logged in the 
patron can access their reserves through My Profile. To view and delete reserves from 
My Profile:

1. On the iPAC home page, click Login
2. Enter the Client Barcode and the PIN/Password
3. Click Login
4. My Profile screen will appear, click Reserves button or click the Reserves tab
5. The Reserves screen appears with all current reserves listed.

6. Do one of the following:
• Select the checkboxes beside the items to remove from reserves and click 

Delete Selected Reserves
• Click Delete All Reserves

7. If everything is correct, click Confirm
• To make adjustments before finalizing the deletion, click Go Back

8. The iPAC returns to the updated reserves screen

Send Bookbag by Email
If enabled in their Homeroom preferences, patrons can send their bookbag contents to 
their email account. The bookbag can be sent in text or HTML format in a biblio-
graphic listing. The email settings in Preferences have to be configured and the 
patron’s email and mail server must be entered into the patron’s record in Client Man-
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agement before L4U can send the emails. Please see “Email” on page 52 in the L4U 
Users Manual for more information on how to enter global email settings. Your Dis-
trict Technician or IT Department will have this information. Patron specific informa-
tion is entered in the respective patron record in the Client File. To Send a Bookbag 
List via email:

1. On the iPAC home page, click Log In
2. Create a bookbag
3. Click My Profile
4. Click Email Bookbag

5. The Email Biblio-
graphic contents of the 
Bookbag screen will 
appear. If required, 
change the destination 
email.

6. Make any desired 
changes to the Email 
Format Options & Sort 
Options 

7. Click Send. This may 
take up to 60 seconds depending on various email server settings.

Text Format HTML Format

My History
If Client Histories are being maintained by the library (see “Item/Client Histories” on 
page 39 in the L4U Users Manual), then information about your current and previous 
circulations is available.
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To view your history:

1. From any iPAC page, Login to My Profile, see “My Profile” on page 65.
2. From the My Profile screen, click My History

Basic Circulation on the Web
L4U Freedom users can perform Basic Circulation on the web in addition to Freedom 
Circulation. Basic Circulation allows library administrators to assign limited circula-
tion privileges to trusted groups of library patrons. Control over what features of cir-
culation are available to a user is specified in the user’s Homeroom. For example, a 
librarian may allow teachers to circulate materials to their classes or allow self circu-
lation but without all the features of full circulation. Please see “Setting Web Privi-
leges” on page 27 for more information.

Checking Items Out
Circulation on the web can only take place after the patron has logged in with a valid 
client code and PIN/Password. Circulation and the various optional settings associ-
ated with it must be enabled prior to login. To perform basic circulation via the web:

1. From any iPAC page, Login to My Profile, see “My Profile” on page 65
2. On the My Profile page, click Basic Circulation
3. The basic circulation screen will automatically display with the currently logged-

in patron’s information, including any items that are currently checked out
• Depending upon options selected in Web Privileges, this screen can include 

the patron picture
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• Overdue items will display with a RED date due
4. To circulate an item out to the current user, Enter the item barcode in the field 

provided
5. Click Proceed
6. The item Title and, if available the book cover will display with a status of Out-

going

Note: To view more information about the patron account, such as, homeroom or 
fines owing, click the blue Info button to the right of the Client Name. 

Circulating to Other Patrons
If enabled in the Web Privileges, patrons may be allowed to circulate items to other 
patrons. This type of circulation is performed the same as if you were circulating to 
yourself with the exception of entering the other client’s barcode. To circulate to 
another patron:

1. From any iPAC page, Login to My Profile, see “My Profile” on page 65
2. On the My Profile page, click Basic Circulation
3. The basic circulation screen will automatically display with the currently logged 

in patron’s information, including items that are currently checked out
• Depending upon options selected in Web Privileges, this screen can include 

the patron picture
4. Scan or Enter the Client’s barcode in the field provided. click Proceed. The new 

patron’s information will appear
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• To Search for a Client, type the patron’s first or last name and then Click the 
Search icon. Type in the first and last name for a more accurate search

5. Scan or Enter the item barcode. Click Proceed
6. The item Title and, if available the book cover will display with a status of Out-

going
7. If the same patron is checking out multiple items, repeat steps 8 and 9 for each 

item
8. To move on to a new patron, simply enter the client barcode and click Proceed.
9. This process can be repeated for as many patrons and/or items as necessary.

Note: At any point during circulation, if you need to clear the information displayed 
on the screen, click the red Clear button.

Checking Items In
If this option is selected in Web Privileges, patrons can check items in through the 
basic circulation feature. A patron must login with a valid client code and PIN/Pass-
word and then select the Basic Circulation from My Profile. To check an item in, sim-
ply enter the item barcode and click Proceed. The item information with a status of 
Incoming and the information for the patron that last borrowed the item will display.
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Circulation Warnings
If a patron attempts to perform a function that has not been activated, they will 
receive a message under Circulation Information and the process will not be allowed.

Circulation Period Hierarchy
When an Item is checked Out from the Library, the length of time the Item will circu-
late for is determined by several settings (Example: Loan Type, Client File, Circula-
tion, etc.).The circulation period can be controlled on several levels, therefore a 
hierarchy must exist with specific settings always taking precedence over others. The 
hierarchy is listed below from lowest priority to highest.

Loan Type Code
Each item in the library collection has a mandatory Loan Type Code. Loan 
Type Codes are assigned a circulation period. When an item is circulated, its 
due date is based on the number of days in its designated loan type circulation 
period.

Note: The Loan Type Code can be configured to override the Client’s Circulation 
Override. To use this feature, see “Creating Loan Types” on page 75 in the 
L4U Users Manual.
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Client Circulation Override
A Client’s Circulation Override value will take precedence over the Loan 
Type Code circulation period. This setting is useful for patrons who require 
set circulation periods that usually exceed a normal Loan Type period. For 
Example: If a Patron with a Circulation Override of 10 days checks Out a 
book with a Loan Type Code set to 7 days, the due date will be 10 days from 
the current date.

Circtime Override
By selecting Circtime Override within Circulation, an alternative circulation 
period can be entered when checking an item Out. The value entered will 
override all other loan periods, excluding the Global Due date. A setting 
within Preferences will determine whether L4U requests a due date or the 
number of circulation days. To change this setting, see “Circtime Override 
Options” on page 46 in the L4U Users Manual.

Global Due Date
This is the highest level in the circulation hierarchy. For a district wide set-
ting, this date is set in Preferences and is the last possible due date This date 
will override all other circulation periods. Global Due Date can be used for 
collecting materials before an inventory or library closure. This date must be 
entered in the correct format for proper program functionality (MM/DD/
YYYY). Locations can have their own Global Due Date and is discussed in 
“Location Due Date” on page 19 in the Enterprise Administrator Manual.

Log Out
It is best practice to always log out of L4U on the Web once you have completed your 
work. This ensures that no one else is able to view your account or perform transac-
tions under your login. To log out of L4U on the Web:

1. Do one of the following:
• From a Freedom page, click 

iPAC to return to My Profile, 
then Click Log Out

• From any iPAC page, Click 
Log Out
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2. Do one of the following:
• Click Yes, Logout and save my 

session to return later. This 
option will have L4U restore 
the contents of your bookbag 
upon your next login

• Click Yes, Logout and delete 
my session. This option deletes 
the contents of your bookbag

• If you selected Log Out in error 
and would like to return to the 
iPAC, click No, please return

3. The iPAC home page appears

Quit iPAC
The steps to quit the L4U iPAC differ entirely depending upon your connection type. 
If you are accessing the iPAC through a web browser, on the browser menu, File > 
Exit or File > Quit depending on your operating system.
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Posting to the Library File
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Freedom Acquisitions
The Acquisition File acts as a holding tank for Items that are not yet ready for Circu-
lation. It is the main point of bibliographic data entry into L4U. New Item records are 
created either through manual (original) entry or copy cataloging from materials in 
the Library File or from the Internet (CheckMARC). An Item record is any material 
or media type within the library collection. Acquisitions in L4U Freedom:

• is a place to store new items or items on order
• is a place to store items you hope to add to the collection
• does not make items available for circulation or searches in the iPAC
• the items can be modified after saving as long as they haven’t been posted

Note: Control over what Freedom features are available to a user is specified in the 
user’s Homeroom, see “Setting Web Privileges” on page 27. 

Navigating Freedom Acquisitions
Cataloging materials in L4U Freedom is quick and easy. Use the onscreen navigation 
buttons and links to quickly jump to the part of the record that needs attention. The 
buttons on the Acquisitions Toolbar select the corresponding Acquisitions section.
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These buttons move to the top of the data 
entry screen. (See image to the right.)

Anytime an Item record is added to the 
library collection, it should be entered into 
the Acquisitions File. This is the only area 
of the program in which an Item can exist 
without a unique Accession Number. This 
is how Items not currently circulating can 
be cataloged in advance.

Certain fields within an Item record are mandatory, including Title, Status, Loan Type, 
Department, Media, Vendor, Publisher and Location. All of these fields excluding 
Title use the default settings established in Preferences either Location specific or 
District wide, see “Acquisitions Defaults” on page 30 in the L4U Users Manual.

Tips and Tricks for Data Entry
• Use the Freedom Dashboard navigation buttons (ie: Save, Next, 

Previous, Cancel, etc) to move within Freedom and not the Inter-
net Browser Forward and Back buttons.

• Press F11 on the keyboard to dismiss the Internet Explorer/
Firefox navigation buttons. Press F11 to bring them back. More of 
the Freedom screen is now visible. Safari has similar commands 
via the View menu.

• To move between fields, use the mouse or TAB. To reverse direc-
tion SHIFT + TAB

• All fields with associated Authority Files or Control Files utilize 
drop down lists for easy entry. In the appropriate field, type in the 
first few characters and a list containing all matches will appear. 
Click the correct entry to select. If no match is found, simply con-
tinue typing.

• When entering data into a Control File field (Loan Type, Depart-
ment, Location and so on), a complete list of all available codes 
can be viewed by typing @.

• Cutter will be automatically generated upon saving a new record. The Cutter 
is taken from the first three letters of the Author’s last name. If no Author is 
present, L4U will use the first three letters of the Title.

• To quickly Rebuild the Cutter or 
Local Call Number, click the 
Rebuild Icon to the right of the 
corresponding field.

• Copy Cataloging shortcut buttons 
are available for ISBN and Title 
and speeds up data entry. See 
page 83.
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• If a Title is entered starting with an article (The, An, A, etc.), L4U will auto-
matically move it to the end of the Title when the record is saved.

• When selecting Tag # in Description area, the Up and Down Arrows can be 
used to navigate to the correct MARC Tag or just type the Tag # in the tag 
field.

• To Delete a line of unwanted data, click 
the X icon to the right of the unwanted 
line.

• Many new materials have a UPC bar-
code which is the ISBN-13. Look at the number under the UPC. If it starts 
with 978, Scan this barcode into the ISBN field and then click CheckMARC.

• To exit the Acquisition record without saving, click Cancel, Acquisitions 
Home or Exit from the appropriate Toolbar.

• Log Out of Freedom (see “Log Out” on page 77) instead of just closing the 
Internet Browser window.

Cataloging in a Union Catalog with L4U Enterprise
A Union catalogue is the combined holdings of two or more libraries or collections. If 
the library administrator allows you to catalog for more than one collection, L4U 
needs to know which collection your administrative tasks will affect. If so, Select a 
location from the drop down list before performing Freedom administrative tasks. If 
the drop down list is not available, then you have access to only one collection.

To Create an Item Record
1. In iPAC, login to Freedom, see “L4U Freedom Login” on page 66
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2. Click Acquisitions

3. Click Add Record
• The Accession # and various other fields will automatically be entered using 

the default settings in Preferences. To change these default settings, see 
“Acquisitions Defaults” on page 30 in the L4U Users Manual.

4. Tab or Click between fields to enter all relevant information
5. Scroll or tab to the various Sections to enter additional information

• See the following Field Definitions for specific information on data entry
6. Click Save

• To exit without saving, Click Cancel or Click Clear

Warning: Data additions or modifications will only be saved once the Save button 
has been clicked. If the record is exited without clicking Save, all data addi-
tions or modifications for this record will be discarded.

Copy Cataloging from the Library File
L4U can speed up cataloging by pulling bibliographic information from items cur-
rently in your collection. This is known as Copy Cataloging. If L4U locates a match 
while entering an ISBN or a Title, clicking the Copy button will pull the item’s infor-
mation from the Library File. To Copy Catalog during Item Entry:

1. From Acquisitions Management screen, Click Add Record
2. Click in the ISBN or Title field and start typing the ISBN or Title respectively
3. After a few charac-

ters, L4U may find a 
match and display 
them in a drop down 
list.

4. Click the desired 
item.



L4U Web Manual

84

5. Click the green arrow at the end of the 
Title field if the search was performed 
on Title or at the end of ISBN field if 
the search was performed on ISBN.

6. L4U copies the MARC record from 
the Library File

7. Make any desired edits
8. Click Save

Field Definitions
Field definitions are provided for those fields with special requirements and/or 
options. An explanation of the available fields within the Common screen follows.

Common
This is the Primary Information for the catalogued material.

Accession #
Accession # is also known as the barcode. This field should contain a unique 
Accession # within the local collection, although this accession number may 
be in use at another location.

• If using pre-printed barcodes, scan the barcode into this field after 
affixing the barcode to the item being cataloged.

• If L4U is generating the Accession 
#, Click the # icon to generate the 
next Accession #.

L4U can be configured to generate the next 
Accession # on a location by location basis or district wide. Please see Bar-
codes in the L4U User Manual for more information.

Note: The Accession Number of an item can only be modified or left blank while 
the item remains in the Acquisitions File. Once the record has been Posted to 
the Library File, the Accession # becomes fixed and cannot be edited. The 
Accession Number & Title are the two mandatory fields in a new item.
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Copy
When items are duplicated using the Duplicate button, the program automati-
cally increments the Copy Number by one for every additional copy of the 
item. This field represents the total copies for that title in that location.

ISBN
The International Standard Book Number assigned to each edition of a book 
as determined by designated agencies in each country participating in the 
ISBN program. Enter either 10 or 13 digit ISBN's as appropriate with or with-
out hyphens.

Status
This is a required field that describes the availability of an Item. Although an 
Item may have any Status while in the Acquisition File, it must have a Status 
of Arrived before it can be posted to the Library File. Once in the Library 
File, a record must have a Status of In for it to be available for circulation.

Title
All Library Items must have a Title. To enter a Title, type in 
the first few characters, and a list containing all matches 
will appear. Click the correct entry to select. Click the 
Green Arrow icon to copy the bibliographic from the 
Library File. Please refer to “Copy Cataloging from the 
Library File” on page 83 for more info on Copy Cataloging. If no match is 
found, simply continue typing.

Subtitle
The Subtitle is used for the remainder of the Title. This may include a parallel 
Title or other Title information.

Edition
Information relating to the edition of a work as determined by applicable cat-
aloging rules.

Author, Author 2
These fields contain the names of the person, or persons, responsible for the 
creation of an item. Standard practice is to enter the Author’s name in reverse 
order. For Example: Blume, Judy. This field may also contain the name of a 
corporate body or conference responsible for the creation of the item. To 
enter an Author or Author2, type in the first few characters and a list contain-
ing all matches will appear. Click the correct entry to select. If no match is 
found, simply continue typing. The new Author will automatically be added 
to the Authority File when the item record is saved.
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Publisher
Publisher is a mandatory field for which an Authority File is maintained. To 
enter a Publisher, type in the first few characters and a list containing all 
matches will appear. Click the correct entry to select.

Pl/Pub
A Place of Publication can be entered with an associated Publisher in the 
Control File, see “Creating Publishers” on page 84 in the L4U Users Manual. 
By doing so, the Place of Publication will automatically be entered when the 
Publisher is selected. If no associated Publisher has been assigned, simply 
Click in the Pl/Pub field and type in the appropriate information.

Yr of Pub
The copyright date or year of publication is entered in this field.

Call #
The Call # or the shelf location of an item is entered in this 
field. If left blank, upon saving the record L4U will automati-
cally generate a Call # comprised of the Loan Type, Dewey 
and Cutter. To prevent L4U from automatically adding the 
Loan Type to the Call #, see “Automatic Local Call Num-
bers” on page 31 in the L4U Users Manual. To quickly rebuild the Local Call 
Number, click the Rebuild Icon to the right of the field, see page 81.

Dewey/LC
This field contains either the Dewey classification or elements of the Library 
of Congress Call Number. 

Cutter
If left blank, upon saving the record L4U will generate a Cutter consisting of 
the first three characters of the Author field. If the Author field is blank, L4U 
will use the first three characters of the Title as the Cutter. The Cutter also 
appears as the Call Letters, which follow the Dewey in the Call #. To quickly 
rebuild the Cutter, click the Rebuild Icon to the right of the field, see page 81.

LCCN
The Library of Congress Control Number (LCCN) is a unique number 
assigned to a USMARC record by the Library of Congress.

CheckMARC
CheckMARC Platinum is a cataloging tool built in to L4U. Please “CheckMARC in 
Freedom Acquisitions” on page 94 for more information. 
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Main
The Main Screen section contains the important Control Files and other fields.

Loan Type
Loan Type is a mandatory field. The code entered here determines the circula-
tion period of the item. To Enter a Loan Type, type in the first character and a 
list containing all matches will appear. Click the correct entry to select.

Media
Media is a mandatory field. The code entered here is the General Material 
Designation. To enter the Media, type in the first character and a list contain-
ing all matches will appear. Click the correct entry to select.

Department
Department is a mandatory field and is entered in the same manner as the 
Media and Loan Type. To enter the Department, type in the first character and 
a list containing all matches will appear. Click the correct entry to select. If it 
is necessary to hide an item from the iPAC, it is done so through the use of 
Departments. For more information on the uses for Departments, see 
“Departments” on page 81 in the L4U Users Manual.

Vendor
Vendor is a mandatory field and is entered in the same manner as Loan Type. 
To enter the Vendor, type in the first character and a list containing all 
matches will appear. Click the correct entry to select. The Vendor code 
entered here is used to identify the source of the material being cataloged.

Location
The Location field is usually set by the L4U Enterprise Administrator. Please 
see “Cataloging in a Union Catalog with L4U Enterprise” on page 82.

Editor/Illustrator
This field contains the Editor or Illustrator information. To enter an Editor/
Illustrator, type in the first few characters and a list containing all matches 
will appear. Click the correct entry to select. This information can also be 
copied and pasted from the Added Entries Tab.
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Series
Series is a collective title used for a group of items that also possess individ-
ual titles. To enter the Series, type in the first few characters and a list con-
taining all matches will appear. Click the correct entry to select. If no match is 
found, simply continue typing. The new Series will automatically be added to 
the Authority File when the record is saved.

Level
This field is used for information that identifies the specific audience or intel-
lectual level for which the content of the described item is considered appro-
priate. The designation can be either reading, interest or age level.

Condition
The Condition field allows users to identify and track the condition or state of 
the item.

Cost
The Cost is the original price of the item at the time of purchase. This field is 
necessary in order for other features such as Purchasing, Orders, Claims and 
Serials to work effectively.

RV
The Replacement Value (RV) of an item, the expense incurred by the library 
to replace the item if it were to be damaged or lost, is designated by the user. 
RV can be assigned automatically using a formula based on the Cost. This 
formula is entered in Preferences, see “Replacement Value” on page 32 in the 
L4U Users Manual.

ISSN
The International Standard Serial Number (ISSN) is assigned to a serial publi-
cation by a national center under the auspices of the International Serials Data 
System.

Volume/Issue
L4U will automatically populate this field when generating multiple Issues 
for a Serial. This field can also be used to track the Volume designation of the 
individual item within a Series.

Pages
This field is reserved for the physical description of the item being cata-
logued. More specifically, the extent information should be entered here.
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Entry/Issue
The date the item is originally entered into the data file is automatically 
entered here. This field can be modified when the item is posted to the 
Library File, or when the Status is changed.

User Field 1 - 3
These fields are provided to the user for additional administrative informa-
tion. They are locally defined and can be searched and viewed only in the 
Administration level.

Note: User Fields cannot be renamed but can be exported as part of the MARC 
record.

Subjects
All Subjects are added to an individual Item record from Subjects. Subjects can be 
used from the existing Subject File and new Subjects can be created.

Adding a Subject
1. While in an Item record, Click Subjects icon in the Navigation Bar
2. In the field provided, Enter the first few characters of a Subject

• A list of Subjects appear that start with the search criteria
• If the required Subject is not displayed in the list, type out the complete Sub-

ject
3. Highlight the appropriate Subject in the list

• Tab or Click to the Tag field and 
Enter the appropriate Tag/Sub-
tags or Tab or Click to the next 
Subject field to accept the 
default Tag/Subtag.

• The Subject is now added to the 
list

4. Continue to Tab or Click to the next Subject field to add extra Subjects
• Click the X icon to the right of an unwanted Subject to delete

5. Click in any other field to finish entering Subjects 
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Description
The Description field can be comprised of various types of information such as Sum-
mary, Bibliography, Statement of Responsibility, etc. These data types can be 
assigned to their individual MARC tags when creating new materials or when editing 
the material. If specific MARC tags are not necessary, just enter the description as 
needed into one Description entry. All data entered in this way will be saved in the 
MARC record under the 500a tag. To enter a Description:

1. While in an Item record, Click Description icon in the Navigation Bar
2. In the field provided, Enter the Description
3. Tab or Click to the Tag field and Enter the appropriate 

Tag/Subtag or Tab or Click to the next Description 
field to accept the default Tag/Subtag.

4. Continue to Tab or Click to the next Description field 
to add extra Description.
• Click the X icon to the right of an unwanted line to 

delete
5. Click in any other field to finish entering the Descrip-

tion

Note: Keywords are created after the item is saved.

Added Entries
The Added Entries section stores names, titles and/or terms that provide access to a 
record that is not given through the main fields. This field is used for entries such as 
additional persons responsible for the creation of an item (translators, photographers, 
etc.), additional titles, and/or translations of a title. To create an Added Entry:

1. While in an Item record, Click Added Entry icon in the Navigation Bar
2. In the field provided, Enter the data
3. Tab or Click to the Tag field and Enter the appropriate Tag/Subtag or Tab or Click 

to the next Entry field to accept the default Tag/Subtag.
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4. Continue to Tab or Click to the next 
Entry field to add extra Entries.
• Click the X icon to the right of an 

unwanted line to delete
5. Click in any other field to finish entering the Added Entries 

Info
The Info section contains fields such as Donated By. Although these fields are not 
mandatory, PO# and Entry/Issue (see page 89) are useful when using the Claims fea-
ture of L4U.

Donated By
If applicable, enter the name of the individual or organization that funded or 
donated the item. This field may also be used to track the budget source.

Imported Via
This field tracks the origins of imported records, and is entered automatically. 
When records are imported from a vendor disk for example, the source (File-
name) of the record will appear in this field.

Duration
Enter the playing time of videos or filmstrips, etc. The standard format for 
entry is hhmmss.

Bibliographic Note
Sometimes it is desirable to record information about an item when that item 
is being circulated. This is useful for Temporary Barcodes (see page 154). 
Also, use it to record extra information about an item, such as kit contents or 
items that have to be returned with the item. If the Department Code is VF, 
then the Bibliographic Note will appear when the item is circulated In or Out. 

PO#
The Purchase Order Number can be manually entered or assigned by default. 
If a large number of materials are being catalogued from one purchase, set the 
PO # as a default in Preferences, (see “Administration” on page 29 of the 
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L4U Users Manual) and the purchase order number will automatically be 
generated and entered in this field.

Model #
Model #’s can be entered to help identify pieces of equipment within the 
library collection. For Example: VCRs, projectors, etc.

Serial #
Libraries often maintain multiples of the same equipment. For Example: 
VCRs, televisions, computers, etc. Individual Serial #’s can be entered to dif-
ferentiate between similar items.

Resources
URLs (Universal Resource Locators), or Web site addresses associated with the Item 
can be entered in this tab. These links and /or their ‘friendly’ name are displayed 
when the record is viewed from the iPAC. The URLs, or links, can be accessed 
directly from the library record. This feature can also be used to link files to a record 
such as eBooks or other eResources. The process for Adding files is similar to that of 
a URL.

Adding URLs
Often it is helpful to include related website addresses to items within your collection. 
These links can be accessed by the patron as they view the item record online. To add 
a URL to an item record:

1. While in an item record, Click the Resources icon in the Acquisition Toolbar
2. Enter the full website address in URL

• Enter http:// and www if applicable. (This ensures that the URL works prop-
erly, even in older Internet browsers)

3. Enter the name as it is to appear on the iPAC screens in the URL Name
4. To add more URL's, Click the Green Plus button or to delete a URL, Click the 

Red X button
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Adding Resources
In addition to attaching a URL to an item record, L4U call attach practically any file 
to an item record. It is up to the internet browser to open and properly display the file 
type. Files such as .jpg, .gif, .png, .wmv, .mpg, .mov, .wav & .pdf can be opened by a 
modern browser. The file is not externally referenced, but is added to the datafile. To 

add a resource to an item record:

1. While in an item record, Click the Resources icon in the Acquisition Toolbar
2. Enter the Display Name under File Resources (the name as it is to appear in the 

iPAC)
3. Click Upload
4. Click Browse and navigate to the file location

• After locating the file, Click Open
5. Click Upload

Bookcover
L4U will attempt to locate a bookcover and include it with the L4U record. Some-
times a CheckMARC search fails to locate a bookcover. L4U can search Amazon for 
a bookcover that matches the item’s ISBN. To do so:

1. Locate the item using Quick Search or any other means
2. Open the item by double clicking it or Click the pencil icon
3. Verify the item has a valid ISBN10 or 13

• If the ISBN is missing from the ISBN 1 
field, L4U will attempt to find a bookcover 
with a combination of Title, Author and 
Publisher.

4. Click the Resources icon in the Acquisition File 
Management toolbar or scroll down to the 
Resources section

5. Click Search the Web for a Bookcover
6. L4U will either:

• Find a Bookcover Click Save to save the item with the new bookcover
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• Find an Incorrect Bookcover If the ISBN is correct but it is the wrong book-
cover, either Click Cancel to discard this selection or try the suggestion below 
in Find No Bookcover

• Find No Bookcover Go to Amazon.com and perform a title search for the 
material. Copy the ISBN13 from the item’s record and try that ISBN for the 
bookcover search.

7. Click Save or Cancel as appropriate.

CheckMARC in Freedom Acquisitions
CheckMARC Platinum is a cataloging tool built into L4U. This service is included 
and is annually renewed as a subscription. Installations that are licensed to include 
CheckMARC Platinum have the ability to search multiple MARC record providers 
simultaneously. Currently, those locations include Library of Congress (LOC), Ama-
zon.com and CheckMARC (CheckMARC is the MARC record database maintained 
by L4U Library Software).

CheckMARC is first configured in the Preferences area of L4U and then is used 
within the Acquisitions file. CheckMARC increases cataloging efficiency by search-
ing for and importing MARC records directly from the cataloging screen. Catalogers 
simply enter as little or as much information as desired (For Example: ISBN and 
Title) and then Click the CheckMARC icon. L4U automatically searches the activated 
MARC sites and displays all matching results. Cataloguers can then review the vari-
ous matching records and select the one they wish to use. The record is imported into 
L4U with the click of a button and then any necessary changes and/or additions can 
be made to the record. This process can increase cataloging speed by up to eighty per-
cent.

CheckMARC Setup
The District Librarian would setup and configure CheckMARC prior to first use of 
the software. CheckMARC must be enabled in your License Number before the 
CheckMARC preferences become available. If you open Preferences and the Check-
MARC options are inaccessible, your license may not be entered correctly. Contact 
L4U Library Software for information on purchasing CheckMARC Platinum or 
obtaining the correct license number. Please refer to CheckMARC Setup in the L4U 
Users Manual for information on CheckMARC preferences.

Cataloging with CheckMARC
Once the preferences have been set for CheckMARC you are ready to start catalog-
ing. As with normal item record entry, this takes place in Freedom Acquisitions. To 
catalog with CheckMARC:

1. In iPAC, login to Freedom, see “L4U Freedom Login” on page 66
2. Click Acquisitions
3. Click Add Record
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4. Enter as much or as 
little data as preferred
• The more informa-

tion provided, the 
more accurate the 
search

• Ideally, the ISBN 
or LCCN and Title 
are used

5. Click CheckMARC
6. Steps are continued on 

page 97

Note: Press ESCAPE to 
cancel the CheckMARC Search.

Selecting a Record
The search is conducted first using the ISBN or LCCN and then if no match is found, 
L4U will continue searching using the fields of data entered. For Example: If you 
enter a record with the ISBN, Title and Author, Series or Publisher, L4U will try 
searching by the ISBN. If no match is found, L4U will search using the Title. If still 
no match is found, L4U will use the author and so on through all the available data. 
L4U will automatically display the best match as the default in the Online Search 
Results screen.The best match being first from the LOC, then CheckMARC and then 
Amazon. Each location has a tab with a counter. This counter lists the number of 
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matches obtained from each of the locations and the highlighted tab represents the 
location that the currently displayed record is from.

Record Matches by Location
If the counter indicates that 
matching records have been 
obtained from the various loca-
tions, these results lists can be 
viewed by Clicking on the 
appropriate tab, then scrolling 
down to see more results than 
the suggested hit. To view the 
details of a specific record in the 
list, simply Click the Title of the 
desired record. Click Collapse 
to hide the detail of the selected 
record.
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Viewing Record Detail
Individual record detail 
is viewed by Clicking 
the title of the record in 
the list view. Check-
MARC loads the item 
and displays it below 
the Collapse and Import 
buttons. This view 
shows the record in 
tagged display and 
includes the L4U Field 
that each tag and sub-
field is mapped to. View 
the complete record by 
using the scroll bar to 
the right of the record data.

Saving a Record
Once you have located a record that you wish to use, you will need to save it in the 
Acquisitions file. From there, you can then edit the import per your local cataloging 
rules. These steps are continued from above:

7. The Online Search Results screen appears with the default record displayed
• If no records are found, a message appears. Click OK to clear it.

8. View the alternate records to ensure this is the record you wish to use
9. Click Import

• If no record is appropriate, 
Click Start New Search and 
redefine your search or cat-
alog the item manually

10. The Acquisitions cataloging 
screen appears with all the data 
automatically entered

11. Review the record and make 
any additional cataloging 
changes required

12. Click Save

Importing MARC Records
Importing MARC records is the most efficient means of creating a complete library 
collection. Although MARC records can be downloaded or entered manually, import-
ing MARC record files from vendors or other cataloging sources can save valuable 
time. When importing MARC Records, it is helpful to know the holdings fields that 
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are used within the records, see “Holdings Fields” on page 310 of the L4U Users 
Manual. If this information is not provided by the supplier, there is an opportunity 
during the import process to verify the necessary information.

To Import MARC records:

1. From Acquisitions Management, Click Import MARC Records
2. Click Browse

3. In the open dialog, Locate and Click the appropriate file, Click Open
• Click the Acquisitions button or Exit to return to the previous screen if you’re 

not ready to import
4. Click Upload File
5. Choose the necessary options. See “MARC Options” below for more information 

on these options
6. Click Import
7. A screen appears indicating the import is being performed on the L4U Server, 

Click Return to Acquisition Main Page to return to Acquisition Management or 
Go Back to the Import MARC Records screen to import another MARC file
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MARC Import Options

Diacritical Processing
Diacritics (accented characters in French, Spanish, etc.) can produce undesir-
able results if the proper processing is not selected. MARC record vendors 
adoption of one standard over another is slow so there are several options to 
choose from in L4U. They are:

• No Processing (UTF-8): this is the default choice and is becoming a 
industry standard in the World Wide Web.

• Regular iso-8559-1: an older encoding method that supports diacrit-
ics better. 

• iso-8559-1 and DOS postprocessing: many book vendors still use 
this method to encode their MARC records and is recommended if 
diacritics do not display properly after importing. 

However, if one option does not produce the desired results after importing, 
select another option and re-import. 

MARC Template To Use
• From the MARC Template To Use drop down menu, Select the 

appropriate template. 
For information on creating and modifying templates, see page 320 
of the L4U Users Manual.

Accession (Barcode) Numbers
• If pre-printed barcodes are being used, then select Leave Accession 

Numbers Blank. These numbers can then be assigned manually in 
the Acquisitions File prior to posting.

• Let L4U Assign Next Accession Number will automatically generate 
numbers based on the Preference Settings. A confirmation screen 
appears to verify next available number.
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• Use Accession Number from the MARC Record should be used only 
if the records contain Accession Numbers and the Import template is 
set up to accept them.

Select Fields to Import
The options in this section enable the user to import specific fields. These 
fields must exist in the MARC record, and the tags must be assigned in the 
import template. If the data does not exist or the tags are incorrect, the fields 
will be left empty. When the data does not exist in the MARC record, do not 
select the option to import and L4U will generate the field using Entry 
Defaults. The Current Location is assigned to the imported data. See “Cata-
loging in a Union Catalog with L4U Enterprise” on page 82 for more infor-
mation.

Advanced Features
• Attach Imported Cutter to Imported Call Number is used if the call 

number has been broken into two separate Tags. Cutter and Local 
Call Number must be selected in Select Fields to Import before this 
option is enabled.

• Take Dewey from Imported Local Call Number creates a separate 
Dewey field using the first component of the Local Call Number. 
This option does not recognize alpha designations (Example: FIC).

• Import files as MicroLIF (1987) protocol must be selected when 
importing MicroLIF records.

Note: L4U uses the Import Template when importing MicroLIF records and will 
default to the one selected. Users who need to import MicroLIF records on a 
regular basis may wish to create a special MicroLIF Import Template to use 
in place of the standard MARC import template provided with L4U.
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Search
Locating an item in Acquisitions is quick and easy. Once the item is found, it can be 
modified as required.

To Search in Freedom Acquisitions:

1. In Freedom Acquisitions Management, Click 
into the search area and start typing.

2. To change the field to search, Click the Search 
by dropdown and select the desired field.

3. Click the Magnifying Glass to start the search.
• To start another search, type in new search 

information and click the Magnifying Glass
4. Click View All to Show All the items in Acquisition when finished if desired.

Modifying Items
The item can be modified after it is saved. This allows for edits or corrections to 
import or cataloging errors before committing the record to the Library File. All 
MARC tags data assigned to an L4U field will be saved. Please see “What is 
MARC?” on page 310 and “Master Import Template” on page 319 of the L4U Users 
Manual for more information on this feature. To modify an item:

1. In iPAC, login to Freedom, see “L4U Freedom Login” on page 66
2. Click Acquisitions
3. Click the Pencil of the item that 

needs editing or just double click the 
item.

4. Make any changes.
5. Click Save when finished or Cancel 

to discard your edits.

Duplicate
Once an item is entered in the Acquisitions File, it can be duplicated or copied as 
many times as required. This saves having to re-enter the same information for multi-
ple copies of the same item. This feature is especially useful for item records such as 
textbooks, novel sets or encyclopedias. To create multiple copies:

1. Either:
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• Create a new item record and Save it
• If the Item already exists, Locate the item and Click the Title to open it

2. Click Duplicate on the 
Dashboard

3. In the request screen that 
appears, Enter the number of 
additional copies required

4. Click Proceed

Clear All Selections
L4U Freedom will remember selections or subsets when switching between different 
Freedom functions. For example, if 12 items in Acquisitions has 7 items selected and 
then you switch to Library File to check on some other items, the 7 selected items will 
still be selected when you return. If this is not desired, click Clear All Selections and 
all selected items will become unchecked.

Delete
If it is decided an item or a number of items are not needed in Acquisitions, they can 
be deleted one at a time, a selected number of items or the entire selection.
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To Delete items:

1. In Freedom Acquisitions Management, Click the check box beside the item(s) 
that need to be deleted.

2. To select all the items in the current subset or view, Click Select All Items. In the 
above example, all four items would be selected if Select All is clicked, not all 64 
items in Acquisitions.

3. Click Delete.
4. Click OK to confirm the deletion.

Note: Select All Items will only select only the items in the current view. For exam-
ple, if Records Per Page is set to 20 and there are 80 items in Acquisitions and 
all items need to be selected, then select 100 from the Records Per Page. If 
Select All Items is now clicked, all 80 items will be checked.

EZ Labels
Before posting the items, most librarians will print the necessary labels. EZ Labels 
allows for quick and easy label creation of the selected items using the EZ Label tem-
plates provided or templates that have been modified for your needs. EZ Labels is 
also available in other functions of Freedom such as Client Management and Library 
File.

To Print labels using EZ Labels:

1. From toolbar, Select the items using one of the following methods
• Click the Check Box beside each 

item
• Search for the items then click 

Select All
• Select a large Records Per Page 

value to view all the items that 
need labels. In the above example, 
Select 50 Records Per Page would show all 40 items. Then, click Select All.
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2. Click EZ Labels
3. Click Barcode or Spine Label as 

needed.
4. Select the desired template from 

the File drop down list.
5. Click Print.
6. Click Current Page & print onto 

plain paper.
7. Compare the print job with your 

label stock. If it is close enough, 
Click Print All Pages after load-
ing label stock into the printer.

For more information on EZ Labels, please see “Modifying Easy Labels” on page 212 
in the L4U Users Manual.

Posting to the Library File

When an item has been fully cataloged and is ready to be put into circulation, it must 
be posted to the Library File. To qualify for posting, an item must have a Status of 
Arrived and a unique Accession #. Also, it is now possible to post a subset of quali-
fied items by selecting them before posting. Once the item is in the Library File, it can 
be searched and displayed in the iPAC. During the posting procedure, there are 
options available to assist with the continued maintenance of the records.

Note: A maximum of 2000 records can be posted at one time. If the current selec-
tion exceeds 2000, L4U will automatically subset a group of 2000 and post 
only those records.

To Post records from Acquisitions: 

1. In iPAC, login to Freedom, see “L4U Freedom Login” on page 66
2. Click Acquisitions
3. Confirm that only the Items to be posted have a Status of Arrived, a Unique 

Accession # and are checked.
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• Select the Items to post by clicking the check box. This allows to subset a 
range of qualified items.

4. Click Post
5. Under Advanced Features, 

Select the applicable options. 
See Advanced Features below.

6. Click Post
7. Confirm that the number of records in the message box is correct

• To exit without posting, 
Click Cancel

8. A Confirmation Screen appears, 
Click Return to Acquisitions 
Main Page when finished.

Advanced Features

Change Entry Date to Today’s Date
The Entry/Issue field will be updated with the current date for all posted 
records.

‘X’ the Records being Posted
This option Marks with an X all records in the Library File that have just been 
posted. This is a quick method of locating these new records in the Library 
File. The marks can be removed once they are no longer needed, see “Mark 
Item” on page 133 in the L4U Users Manual.

Delete All of the Posted Acquisition Records
When selected, L4U will delete all Acquisition records that have been suc-
cessfully posted to the Library File. This option is recommended unless 
records are frequently reused.

Delete Only Duplicate or Bad Accession Records
When chosen, this option deletes from Acquisitions only those records with a 
bad or missing Accession number. 
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Modifying the Library File
The Library File is a list of all items in the library collection that are currently avail-
able for circulation or have been at one time. While the Acquisitions and Library file 
appear very similar, there are important differences. The Library File:

• Is a place to store items that are viewed in the iPAC and can be cir-
culated

• Allows records to be modified, excluding the Accession #
• Allows users to copy records back to the Acquisitions File for dupli-

cation

Navigating the Library File
Navigating the Library File or more specifically, navigating within the Library File, is 
the same as Acquisitions. In other words, the Dashboard controls for Save, Cancel, 
Previous or Next operate the same way as in Acquisitions. Please see “Navigating 
Freedom Acquisitions” on page 80.

Modifying Item Records
Item Records can be modified in both the Acquisitions File and the Library File. For 
more information on locating & modifying items in Acquisitions, please see 
page 101. Complete information on modifying records is covered in the Data Man-
agement chapter starting on page 111. To modify an Item Record (this example uses a 
record in the Library File):

1. From the Freedom Toolbar, click the Library File icon
2. Locate the item to be changed
3. Double Click the record or Click 

the Pencil icon
4. Make the necessary changes
5. Click Save

• To exit the record without sav-
ing the changes, Click Cancel
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Note: The Accession # cannot be changed in the Library File. The record must be 
copied back to Acquisitions, changed and re-posted. The old record should 
then be deleted.

Ratings and Resources

Rating
It maybe desireable to clear an item’s rating due to a variety of reasons. To do so:

1. Locate the item using Quick Search or any other means
2. Open the item by double clicking it or Click the pencil icon
3. Click the Resources icon in 

the Library File Manage-
ment toolbar or scroll down 
to the Ratings section

4. Click Clear
5. Click Save

• To exit the record without saving the changes, Click Cancel

Resources
Resources can include a variety of files, URL’s or bookcovers. Resources are covered 
in more detail on page 92. However, if an item doesn’t have a bookcover, L4U can 
search Amazon for a bookcover that matches the item’s ISBN. To do so:

1. Locate the item using Quick Search or any other means
2. Open the item by double clicking it or Click the pencil icon
3. Verify the item has a valid ISBN10 or 13

• If the ISBN is missing from the ISBN 1 
field, L4U will attempt to find a bookcover 
with a combination of Title, Author and 
Publisher.

4. Click the Resources icon in the Library File 
Management toolbar or scroll down to the 
Resources section

5. Click Search the Web for a Bookcover
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6. L4U will either:
• Find a Bookcover Click Save to save the item with the new bookcover
• Find an Incorrect Bookcover If the ISBN is correct but it is the wrong book-

cover, either Click Cancel to discard this selection or try the suggestion for 
No Bookcover

• Find No Bookcover Go to Amazon.com and perform a title search for the 
material. Copy the ISBN13 from the item’s record and try that ISBN in the 
Library File record.

7. Click Save or Cancel as appropriate.

Copy
This button will push a copy of the record from the Library File into the 
Acquisition File. This feature is useful when an additional copy of an 
item that already exists in the Library File is acquired. The copy num-
ber for duplicated records will automatically be incremented when 
posting based upon the Title Authority file count for that title. The data 
entry for the item is minimal if the record is first copied to Acquisitions. To copy an 
item record to Acquisitions:

1. From the Freedom Toolbar, click the Library File icon
2. Locate the appropriate item
3. Double Click the record or Click the Pencil
4. Click Copy
5. Click OK at the confirmation dialog box
6. From the Freedom Toolbar, click the Acquisitions icon
7. Locate the newly created duplicate and Open it
8. If the Status is anything other than Arrived, change it to Arrived
9. Make any other changes as required
10. Click Save

• The record is now ready to be posted.
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EZ Labels in Library File
Labels can be printed from the Library File in addition to Acquisitions. Barcode 
labels for materials & Spine labels can easily be printed on a variety of label stock. 
Please refer to page 103 for more information on EZ Labels.



L4U Web Manual

110



111

CHAPTER 5
DATA MANAGEMENT

Working in list view

Quick Search

Subset or grouping records

Marking items in a list

Sorting items in a list

Advanced Queries

Saving, modifying and deleting Queries

Topic Searches

Global Changes
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Overview of Data Management
Data Management is the daily task of keeping the library information up to date. 
Updating acquisitions as orders come in or modifying materials in the shelf list are 
examples of data management. Each of the files in Freedom (e.g.: Library File, 
Acquisitions, Reserves, etc.), are displayed in a list view. Individual records may be 
located and modified.

Quick Search
Quick Search is the fastest and most convenient method of searching in L4U Free-
dom. The more characters that are typed, the more refined the search. Select the field 
that you want to search in. This allows you to quickly locate a record or group of 
records in a file. For more information on Advanced Query, please see “Query In 
Library File” on page 116.

To use Quick Search:

1. The search area displays the 
field that is the default field 
to be searched. To start 
searching on this field, sim-
ply Click into the search area 
and begin typing.
• To change the field to 

search, Click the drop 
down icon and select the 
field from the drop down 
list.

2. Click the Magnifying Glass icon or press RETURN to start the search.
• L4U performs a Starts With search. Use the @ symbol to execute a contains 

search. Example: @kit will find ‘Kites’ and ‘Fun in the Kitchen’. It may take 
longer for matches to display when using a Contains search.

3. The number of records matching the search criteria is shown as records dis-
played.

Note: The default field that L4U searches on is stored in the L4U Session as is any 
search results. Please see “Log Out” on page 77. Also, the Search will 
remember the results of your search until you click View All from the Side-
bar. This allows you to move from one part of Freedom to another and retain 
the results of your search until they are not needed.

Quick Sort
Another method of quickly finding records in a file is through the use of the column 
sort feature. When in the list display of any file in L4U, you can temporarily sort the 
information displayed by the following method.
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• To perform an ascending sort on a single column, Click the column heading
• To perform an descending sort on the same column, Click it again.

• The white triangle indicates the sort order.
The file is sorted and displayed by the information in the column selected. You can 
use this feature after doing a Quick Search or other Query, presenting the records 
matching your criteria in the order of your choice.

Data Management Tools

Although the majority of data management will take place in the Acquisition and 
Library files, the following actions or commands are common to most files in L4U.

View All
The first time any file is entered in the L4U program, the screen appears with the 
complete list of records displayed. At any time while working with different subsets, 
the complete list can be restored by Clicking View All. The list can then be viewed 
using the scroll bar or arrows to the right of the list.

Note: View All will use the Records Per Page to limit how many items appear on 
the web page.
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Subset
When working with a list of records it is often beneficial to reduce the number of 
records being dealt with at any given time. Specific groups of records can be selected 
using the Subset button or the group of items can be the result of a query. Any records 
subset in this way then become the ‘Current Selection’, making them easier to view 
and work with.

Selecting Records

1. Click the check box beside the item(s) that need to be Subset.
2. To select all the items in the current subset or view, Click Select All.
3. Click Subset.

Note: Select All will select only the items in the current view. For example, if 
Records Per Page is set to 20 and there are 80 items in Acquisitions and all 
items need to be selected, then select 100 from the Records Per Page. If 
Select All is now clicked, all 80 items will be checked.

Mark Item
Marking is used for a variety of tasks where any number of items need a temporary 
mark for later identification. These tasks can involve subsetting dissimilar records 
and/or easy location of a group of records. To Mark an item(s):

1. Subset the items to be Marked or locate them using a Search or Query
2. Select the items to be Marked
3. Click Mark
4. Make the appropriate selection when prompted, Do you wish to change high-

lighted records or your current selection?
5. If an X is an acceptable Mark character, Click Save

• If another character is preferable, Enter the Mark (up to two characters in 
length) in the field provided and Click Save

6. Click OK
7. Click OK when the process is complete

UnMark Items

1. Subset the items to be Marked or locate them using a Search or Query
2. Select the items to be UnMarked
3. Click Mark
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4. Make the appropriate selection when prompted, Do you wish to change high-
lighted records or your current selection?

5. Delete the X in the Enter New Value field

6. Click Save
7. Click OK
8. Click OK when the process is complete

Delete
When materials, patrons or reserves records are no longer needed in the L4U data file, 
their records can be deleted.

To Delete records:

1. While in the appropriate file, Subset the records that need to be deleted
2. To select all the items in the current subset or view, Click Select All
3. Click Delete
4. A Confirmation screen appears. Double check the number of records to be 

Deleted and Click OK, or if the number of records is incorrect, Click Cancel
5. Click OK to confirm the deletion

List Search
Use List Search to produce subset lists of items by scanning in their barcodes. This is 
especially useful for creating a subset of disparate materials for marking, global 
changes or deleting.

Note: List Searches are a handy way to weed materials that are no longer needed. If 
you end up with a box full of items, List Search is much faster than deleting 
them one at a time.
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To Use List Searches:

1. While in the appropriate file, Click 
List Search

2. Click in the search field
3. Scan the barcodes of the items to 

be subset
• Barcodes may also be entered 

manually. Use the RETURN key 
between entries.

4. Click Search to display a Subset of all items scanned.
• Click Close to exit without displaying the subset.

Query In Library File
Although other modules in Freedom have a simple or Quick Search function, the 
Query in Library File has extra features and flexibility. The Library File Query is also 
known as Advanced Query as it allows the librarian to perform complex searches and 
save them for later use. These saved Queries can be used to help with weeding, inven-
tory and other projects. Saved Queries can be used in Topic Searches, which are dis-
cussed in more detail in “Assigning a Saved Query to a Topic” on page 121.

Creating and Saving Queries
Searches are built in the Query Editor using available fields and comparison state-
ments. These searches may then be saved to the data file for easy access and regular 
use. Saved searches can be used by any location, but can only be edited by a user with 
the correct permissions for that location.

To create and save a Custom Query:

1. While in Freedom Library File, Click Query List from the Library Management 
toolbar
• A list of saved Custom Queries and Topic Queries appears. Click the appro-

priate tab to show just those queries.
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2. Click Create Query
• The Query Editor appears. 

More information on the 
Query Editor Options is 
discussed below.

3. In the Query Name and Query 
Description field, Type in the 
desired information

4. In the What to Search drop down, Click on the field of choice
5. Click the comparison that is needed from the Command drop down
6. Click in the Value to Search For: and type in the search value
7. If additional criteria are needed, Click the Green Plus icon
8. In the Operator drop down list, Click on the boolean operator (And, Or or Not)
9. Repeat steps 4 to 7 until the complete Query is built
10. Select Wildcard All Queries and/or Search Current Selection if applicable
11. Click one of the following:

• Save to Save the edits and return to the Query List 
• Run Query to open the resulting list in a new Library File window. Close this 

new Library File window when finished to return to the Query that was being 
edited/created. Edit the Query if the query results are not correct.

12. To exit without saving, Click Cancel or Clear to clear the edits and start again.
13. Click Exit from the Query List and return to the Library File window or click the 

Library File icon in the Freedom Toolbar 

Query Editor Options

• Query Name and Description: This area contains the Query Name and 
Description for future reference.

• What to search: This drop down list on the left of the Query Editor contains a 
list of fields in the current file.

• Search Commands: This drop down list is located in the center of the Query 
Editor screen and contains all of the comparison statements.

• Value to search for: field: This is where the search value is entered. It is not 
case sensitive.
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• Boolean Operators: These three options (And, Or and Not) are located at the 
beginning of each line of the Query Editor and are used to invoke Boolean 
logic between the search criteria.

• Green Plus Icon and Red Delete Icon: These buttons allow you to add or 
delete the various lines of the advanced search.

• Wildcard All Queries: When selected, L4U will automatically add the wild-
card character to all of the Search Criteria.

• Search Current Selection: L4U will search the subset items only and not the 
entire file. In essence, a search within a search.

Note: The Command Is Equal To is a literal search. In other words, if CAT is 
entered, only items matching CAT - nothing more, nothing less will be found. 
Add the L4U wildcard, @, at the end of the search criteria to perform a Starts 
With search.

Using a Saved Query
Once a search has been saved, it displays in the Query List and can be used at any 
time. 

To run a saved query:

1. While in the appropriate file, Click 
Query List
• A list of all saved searches for the 

current file will display
2. Click the Green Magnifying Glass 

for the desired Query
• The search results will display

Modifying Saved Queries
Existing searches can be modified after they have been saved. 

To modify an existing search:

1. While in the appropriate file, Click 
Query List
• A list of all searches saved for the 

current file will display
2. Click the Yellow Pencil for the 

desired Query
3. Make the necessary changes or Click 

Clear to clear all edits for this query.
4. Click one of the following:

• Save to Save the edits and return to the Query List 
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• Run Query to open the resulting list in a new Library File window. Close this 
new Library File window when finished to return to the Query that was being 
edited/created.

5. To exit without saving, Click Cancel or Clear to clear the edits and start again.

Deleting Saved Queries
If at any point a search is no longer necessary, it can be completely deleted. 

To Delete a search:

1. While in the appropriate file, Click 
Query
• A list of all searches saved for 

the current file will display
Click the Red X for the desired Query
2. A confirmation dialog box appears, 

Click OK to delete or cancel.

L4U Freedom Query Editor Tips
The Query Editor allows you to perform very complex searches. Multi-Level 
Searches may be executed at one time, however, the search will become 
slower as more criteria are added. The fastest searches are, is equal to and is 
not equal to, and the slowest are Contains and Does not Contain.

Topic Management
Topic Searches allow a librarian to easily build one button searches for their patron’s 
needs. The Topic Searches are then available in the iPAC. For example, a librarian 
could create a series of searches for a reading assisted program that addresses a mid-
dle school curriculum requirements. The patron would then click a button that finds 
all these materials. This list would be dynamic. As materials enter circulation, or are 
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weeded out, the resulting list would update automatically. Also, the librarian can 
choose a picture that fits the nature of this Topic Search.

Creating a Topic Search is easy.

1. Create a Topic: Name the topic and assign a picture to it. In the above screen shot 
of the iPAC, Sports is the topic name and the chosen picture appears here in the 
Topic Search.

2. Create a Topic Query or Queries: Create one or more Topic Queries that appear 

in the Topic. Topic Queries have a picture assigned to them which the patron 
clicks on to produce a list of results.
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Create A Topic Search
Create a Topic and then create a Topic Query:

1. While in Freedom Library File, 
Click Topic Management from 
the Library Management tool-
bar
• A list of previously saved 

Topics appears.
2. Click Create Topic

• The Topic Editor appears.
3. In the Topic Name and Topic 

Description field, Type in the 
desired information
• The Topic Name will 

appear in the iPAC
4. Click Select a New Image
5. Click Choose File, navigate to 

the desired picture and click 
Choose

6. Click Upload File
7. Click Create Topic Query

• Please see “Creating and Saving Queries” on page 116 for more information, 
but at Step 11, Select a image to associate with this Topic Search

8. Once one Topic Query is cre-
ated, Click one of the following 
from the Topic Editor window:
• Save to Save the edits and 

return to the Topic Manage-
ment list 

• Click Cancel or Clear to 
clear the edits and start 
again.

Note: Topic Search Images preferred size is 208 by 208 pixels. Preferred format is 
.png but transparent .gif files as well as .jpg will do. All images are internally 
converted to PNG or GIF and resized. L4U will accept practically any image 
size and format but large images will affect performance.

Assigning a Saved Query to a Topic
It is possible to assign a Saved Query to an existing topic or assign the query to a topic 
when creating the query. To do so:

1. From the Query List, click the Pencil icon on the Saved Query or Create a Query, 
see page 116

2. Click Assign this Query to a Topic
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3. Click Select a New Image to assign a picture to this Search
4. Click Choose File, navigate to the desired picture and click Choose
5. Click Upload File
6. Select the Topic from the Topic Name drop down list

7. Click one of the following:
• Save to Save the edits and return to the Query List 
• Run Query to open the resulting list in a new Library File window. Close this 

new Library File window when finished to return to the Query that was being 
edited/created. Edit the Query if the query results are not correct.

• To exit without saving, Click Cancel or Clear to clear the edits and start 
again.

8. The Query is now assigned to the Topic
9. Click Exit to return to the Library File

Reassign a Topic Query to Another Topic
It is possible to assign a Topic Query to another Topic. To do so:

1. From Library File, Click Query 
List
• A list of all searches saved for 

the current file will display
2. Click Topic Queries
3. Click the Yellow Pencil for the 

desired Topic Query
4. Select another Topic from the 

Topic dropdown list
5. Click Save to Save the edits and 

return to the Query List
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Editing Topics
Sometimes it is necessary to edit a Topic for clarity or another image is desired for the 
Topic. To do so:

1. From Library File, Click Topic Mgmt
• A list of all Topics saved for the cur-

rent file will display
2. Click the Yellow Pencil for the desired 

Topic

3. Select one of the following 
tasks:
• Assign a new image to the 

Topic by Clicking Select a 
New Image

• Uncheck Show in iPAC to 
hide the Topic in the iPAC

• Topic Queries can be 
checked for proper results 
via the Green Magnifying Glass and then Edited if necessary via the Yellow 
Pencil Icon or Deleted via the Red X

• Click Clear to clear the Topic Name and Description
4. When finished, Click Save to save the changes or Cancel to discard the changes

Deleting Topics
If a Topic is no longer needed, it can be deleted. Hiding a Topic is an alternative to 
deleting a Topic, see Editing Topics above. To do so:

1. From Library File, Click Topic 
Mgmt
• A list of all Topics saved for 

the current file will display
2. Click the Red X for the desired 

Topic
3. Click OK to Delete

• Any Topic Queries assigned 
to this Topic are not deleted 
and become Saved Queries

4. Click Save
5. Click Exit to return to Library File
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Globals
Globals permits large 
scale changes to the cur-
rent file. Globals should 
be used when modifying 
a specific field in a large 
number of records. The 
field will be updated in 
all the currently selected 
records, or only the 
records currently high-
lighted. This may mean 
adding a subject to 5 
items, or updating the 
Replacement Value to 75 
items. 

Warning: This is a very powerful and time saving feature. Use caution when mak-
ing any type of Global Change. Global Changes cannot be “undone”. 
Although it is not required, we recommend that a Subset be created of the 
records to be changed before performing the Global Change. It is highly 
advised to ensure that you have a current backup of your data before perform-
ing Global Changes.

Performing a Global Change

1. Subset or Highlight the records to be changed
2. Click Global Changes
3. If records were highlighted but not 

Subset, a confirmation screen appears. 
Select either Current Selection of X or 
the Only X Highlighted records 

4. Click the radio button to the left of the 
field to be changed
• Any changes made to the Loan 

Type or Dewey will prompt the 
request to update the Call Number. 
By clicking OK, L4U will recon-
struct the Call Number using the 
Loan Type, Dewey and Cutter. If 
any of these fields are blank or 
incorrectly entered, the Call num-
bers will not update properly. Use 
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this feature only if the individual records are complete and correct, otherwise, 
Click No.

5. In the New Contents field, Enter the new value
• If Status is selected, a pop up list appears. Click the value to use and Click 

OK.
6. Click Update

• To return to the current file without making any changes, Click Exit
7. A Confirmation screen appears. Double Check the number of records being 

changed and Click OK.
• If the record total is incorrect, Click No

8. An additional Request screen may appear depending on the field being changed
• Do you wish Entry Date updated to Today’s Date?, Click OK to make the 

change or No to leave the Entry Date as is.
9. A confirmation dialog box appears.

Warning: Using the option to automatically update local call number is a very use-
ful tool; however, if used when data fields are incomplete or contain conflict-
ing data, local call numbers will be lost.
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Freedom Client Management
L4U Freedom users enjoy the benefit of creating and modifying Patrons from the 
Web. Items Out and Histories (if enabled in Preferences), can be viewed as well. Con-
trol over what Freedom features are available to a user is specified in the user’s 
Homeroom, see “Setting Web Privileges” on page 27 and is controlled by the District 
Librarian.

Union Catalog Considerations with L4U Enterprise
A Union catalogue is the combined holdings of two or more libraries or collections. If 
the library administrator allows you to work or edit in more than one collection, L4U 
needs to know which collection your administrative tasks will affect. If so, Select a 
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location from the drop down list before performing Freedom administrative tasks. If 
the drop down list is not available, then you have access to only one collection.

To Create a Patron
1. In iPAC, login to Freedom, see “L4U Freedom Login” on page 66.
2. Click Circulation or Client Management
3. Click Add New Client
4. In the fields provided, Enter the appropriate information. Mandatory fields 

include:
• Client Code, must be 

unique and is either 
supplied by the local 
school office/district 
board office or the 
librarian can create a temporary client barcode by clicking the # icon.

• Last Name
• Homeroom

5. Click Save
6. Repeat steps 4 and 5 until all patrons have been entered
7. Click Cancel to return to Client Management

Note: The most efficient way to enter Patrons is to import them from an ASCII text 
file. Please contact your District Librarian to obtain Class Lists for your cam-
pus/location or refer to the Importing/Exporting chapter in the L4U Users 
Manual.
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Patron Information
Client Information contains basic patron information. It includes several fields that 
are entered by the user and others that L4U generates automatically. Some of these 
fields are self-explanatory, where others require some explanation. They are:

Maximum
The Maximum field is for the maximum number of items that a patron may 
borrow at one time. This value must be greater than zero in order for a patron 
to circulate library items.

Suspended
This feature can be used to temporarily suspend Patrons from circulating 
library items. If Yes is selected and the Patron attempts to borrow an item, a 
warning message appears on the circulation station.

Fines/Points
The various fines/points fields are automatically generated by L4U and are 
non-editable fields. The Total Active Fines is the amount owing on items cur-
rently overdue and not yet returned. Whereas the Fines/Points Total is the 
current balance owing on previously accumulated fines for items that have 
been returned. 

Other Charges
The Other Charges Total is only displayed in this field. The itemized charges 
can be entered from circulation or in the Other Charges tab, see “Total 
Charges” on page 150.

Type
Type is a user defined field for identifying Patron categories. This field uti-
lizes a pop up list for entering the value. Example: Teacher vs. Student.

Circ. Override (days)
A Patron’s Circulation Override value will take precedence over the Loan 
Period for the Loan Type Code when circulating materials. This setting is 
useful for Patrons who require set circulation periods that usually exceed a 
normal Loan Type period. For Example: If a Patron with a Circ Override of 
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10 days checks out a book with a Loan Type Code set to 7 days, the due date 
will be 10 days from the date taken out.

Totals
Total Out this Year and Total Items Out Now are L4U generated circulation 
counts that can be viewed only.

Additional Info

The Additional Info tab contains contact information for the patron. As well, it is 
where the PIN (Personal Identification Number) is entered. A PIN has to entered if 
the patron wants to log into L4U. An email address is necessary to send Overdue 
Notices and Bookbag lists. Any information entered in the Message field will be dis-
played in Circulation. The Network Username is only necessary when Active Direc-
tory integration is enabled in Preferences. For more information on Active Directory 
integration, see “Active Directory Integration” on page 54 in the L4U Users Manual.

Items Out

Items Out is a list of all items the patron is currently borrowing from the library. Items 
listed in red are overdue.
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Fines History
If the library administrator has enabled Fines History, then a list of incurred fines & 
other charges will be displayed. It contains details of all payments made on fines and 
other charges including partial payments and waived fines. This is very useful for 
audit trail purposes.

Note: To add Other Charges such as photocopying or lost materials or Manage 
Fines, please see “Total Charges” on page 150.

Histories
Client circulation history is displayed here. Histories are only available when histo-
ries have been enabled in Preferences. Please see “Item/Client Histories” on page 39 
in the L4U Users Manual.

To Modify a Patron
1. In iPAC, login to Freedom, see “L4U Freedom Login” on page 66.
2. Do one of the following:

• Select Circulation
• Locate the patron
• Click Modify Client

OR

3. Select Client Management
• Locate the desired 

patron
• Click the Client Code 

link to open the 
desired patron

4. In the fields provided, 
Enter or Edit the appropri-
ate information. Mandatory fields include:
• Client Code, must be unique and may need to begin with the designated pre-

fix. Client Code prefix is discussed in more detail in “To Create a Patron” on 
page 129,

• Last Name
• Homeroom

5. Click Save to save the edits, otherwise click Cancel to discard

Note: Use the Client Information, Items Out, Fines History & Histories buttons to 
quickly navigate the Patron information.

Searching for Patrons
To locate a patron from the Client File Management window:



Chapter 6 Client Admin

133

1. In iPAC, login to Freedom, see “L4U Freedom Login” on page 66.
2. Select Client Management
3. Do one of the following:

• Scan or manually enter 
the patron barcode or a 
portion of the patron barcode in the Client Code field

• Type the first few letters of the patron’s first or last name in the respective 
fields

• Type the first few letters of the desired homeroom in the Homeroom field
4. Click the Magnifying Glass icon
5. Click the Client Code link to open the desired patron

Patrons can also be entered into the L4U program in other ways. The most efficient 
way to enter patrons is to import them from an ASCII text Tab delimited file. For 
instructions on this procedure, see “Import Client Data” on page 332 in the L4U 
Users Manual.

EZ Labels in Client File
Patron Barcode Labels can be printed from the Client File. The Patron Picture, if any, 
will appear on the label. The process for selecting patrons, printing and minor modifi-
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cations to the template are similar to the process in Acquisitions. Please refer to 
page 103 for more information on EZ Labels.

Homerooms
Homerooms are any division or group of patrons. This can mean homerooms in a 
school, schools within a district or even individual groups within an organization. 
Homerooms are used to track patrons, for Overdue reporting and to determine Web 
Privileges for patrons. Please see “Homerooms” on page 62 in the L4U Users Manual 
for more information on Creating or modifying Homerooms.
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L4U Freedom Circulation
L4U Freedom users have the ability to perform full (Freedom) circulation on the web 
as well as limited (Basic) circulation. Essentially, all the functionality of L4U Admin-
istration Circulation is available in L4U Freedom. This allows libraries to use any 
browser equipped computer as a circulation station. Please see “Basic Circulation on 
the Web” on page 73 for more information on Basic Circulation.

Most of a library’s daily activities take place within Circulation. The Circulation 
screen is used to enter library transactions such as checking items in and out, renew-
ing items currently circulating, processing fine payments and updating or entering 
patrons. L4U automatically updates the status of both the client file and the library 
file every time a circulation takes place.

This is a powerful tool allowing users to circulate items from any web browser in the 
world. Administrators may choose not to allow this type of functionality or perhaps 
allow it for only specific users. Since Freedom Circulation is enabled for individual 
homerooms, access to its functionality can be restricted to authorized users.

Enabling Freedom Circulation
The options for Freedom Circulation is set in the Web Privileges of the individual 
homeroom records. Please see “Setting Web Privileges” on page 27 for more infor-
mation. Also, Freedom Circulation on the Web is governed by the same Circulation 
Setting and Defaults in Preferences as is L4U Administration Circulation. Please see 
“Circulation Settings” on page 41 in the L4U User Manual.

Circulation in a Union Catalog with L4U Enterprise
A Union catalogue is the combined holdings of two or more libraries or collections. If 
the library administrator allows you to work or edit in more than one collection, L4U 
needs to know which collection your administrative tasks will affect. If so, Select a 
location from the drop down list before performing Freedom administrative tasks. If 
the drop down list is not available, then you have access to only one collection. 
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Checking an Item Out
L4U needs a patron entered in Circulation first, then you can circulate materials to 
that patron.

1. In iPAC, login to Freedom, see “L4U Freedom Login” on page 66.
2. Click Circulation
3. Do one of the following to enter the Patron:

• Scan or manually enter the patron barcode in the Enter Barcode Here field 
and Click Enter

• Locate the patron using the Search button in the Circulation Toolbar, see 
“Using the Search Icon to find Patrons” on page 139 for more information

4. Do one of the following to Circulate the materials:
• Scan or manually enter the item barcode in the Enter Barcode Here field and 

Click Enter
• Locate the item using the Search button, see “Using the Search Icon to find 

Items” on page 139 for more information
5. The status will display Outgoing

• The item has now been checked Out

Note: If one patron is circulating multiple items, it is not necessary to re-scan the 
patron code each time. Simply continue scanning or entering the item bar-
codes or titles. Those items will continue to be checked out to the same patron 
until a new patron barcode number or name is entered.
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Checking an Item In
Those Items with a status of Out can be circulated into the library without entering a 
Patron Code.

1. In iPAC, login to Freedom, see “L4U Freedom Login” on page 66.
2. Click Circulation
3. Do one of the following:

• Scan or manually enter the item barcode in the Enter Barcode Here field and 
Click Enter

• Locate the item using the Search button, see “Using the Search Icon to find 
Items” on page 139 for more information.

4. The patron that last borrowed the item will appear, and the status will display 
Incoming
• The item is now checked In

Locating Patrons and Items
L4U offers several means of locating Patrons and Items while in Freedom Circula-
tion. The most efficient method is the use of barcodes. Enter the barcode by either 
manually typing it in, or by using a scanner, and L4U will display either the Patron 
information or the Item information. Occasionally barcodes can become damaged and 
unreadable. In this situation alternative ways of locating Patrons or Items can be used.
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Using the Search Icon to find Patrons
The Freedom Circulation Toolbar contains several icons, one of which is Search. 
Clicking this icon reveals two search areas: Patron Search and Title Search with data 
entry fields. Entering partial information in one of these fields and Clicking the Query 
Icon beside it will provide a list of records to choose from. To use the Query Icon to 
locate a Patron: 

1. Click the Search button
2. Click into the Name field
3. Enter the first several letters of 

the first or last name.
• The more letters entered the 

more specific the search will become
4. Click the Query Icon beside the field containing the search criteria

• Alternatively, press the ENTER key on the keyboard to start the search

5. From the results displayed, Click the desired patron
6. That Patron is entered into Circulation

Using the Search Icon to find Items
A Query Icon is also available for title. Items can be reserved or circulated from the 
resulting list of found materials.

1. Click the Search button
2. Enter the first several letters of the title (do not use articles) into the Title field.

• L4U performs a Starts With search, ie: Search on cat produces Cat, Cats, Cat-
aclysm, etc.

• Start the search criteria with the L4U Wildcard: @ to perform a Contains 
search, ie: Search on @cat produces Captain Cat, My Family Vacation, etc

3. Click the Query Icon beside the Title field
4. From the list of titles displayed, Either

• Click the correct title to circulate the item Out or In. Multiple copies of an 
item appear separately
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• Click the Reserve button to place a hold for that Title. Items with a Status of 
In can be reserved as well.

Circulation Options
Within the Freedom Circulation screen, there are various control functions that can be 
easily accessed. Many of these functions are also controlled in Preferences. For more 
information on the Circulation Settings in Preferences, see “Circulation Controls” on 
page 141. The Preference settings control the defaults, whereas the Circulation Con-
trols control the activity taking place for that current session. These special functions 
include activities such as Status Checks on library items and Fine notifications.

Circulation Modes
L4U defaults to Auto Circulation. This means that items can be checked 
In and Out at any time. During the course of library operation, it may 
become necessary to do a large number of returns or circulations. By 
selecting Incoming Only, items can now only be checked In. This is 
helpful for catching items that have been placed in the return bin without 
ever having been checked out. By selecting Outgoing Only, L4U will 
now only allow items with a status of In to be checked Out to a patron. 
This can be helpful for processing large groups of Patrons. To return to 
Auto Circulation, select Auto Mode.

Auto Mode in summary:
• If the Item has a status of Out when scanned, L4U will circulate 

the Item in
• If the Item has a status of In when scanned, L4U will circulate 

that Item to the currently entered Patron. If no Patron is entered, 
L4U will visually alert the circ operator that a Patron is first 
needed to circulate materials

Note: L4U’s Circulation beeps help with circulation so ensure your 
computer speakers are connected and turned on.



Chapter 7 Circulation

141

To change the Circulation Mode:

1. Select a circulation mode from the Circulation Mode toolbar
• The icon changes color to indicate this is now the current mode

Note: When in Out Only mode, L4U will alert the circulation operator if materials 
have been swapped between users. For example, if a patron has materials that 
are Out to another Patron, L4U will ask the operator if they want this material 
to circulate to the patron, bypassing the step of manually circulating that item 
in first.

Normal Circulation versus Status Check
By default, L4U automatically circulates items both in and out. This is 
called Auto Mode. The Status of an item can be verified without actually 
circulating the item out or in. To check the Status of an item:

1. From within Circulation, Click Status Check from the Circ Mode 
toolbar
• The Mode is now changed to Status Check

2. Scan or manually enter the 
item to be checked and 
Click Enter
• The item’s Status and 

circulation information 
will be displayed.

• These steps can be 
repeated for as many 
items as necessary

3. To return to normal circulation, Select Auto Mode from the Circ Mode toolbar
• The Mode will change to Auto and normal Circulation will resume

Circulation Controls
In addition to the default settings that exist in Preferences, a number of the Circula-
tion options can be changed directly from the Freedom Circulation screen. To modify 
these settings:

1. From the Freedom Circulation Screen, Click Circulation Controls
2. Select the preferred options

• See definitions below
3. Click Apply
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Warning: Any changes to modes or circulation controls do not take effect unless 
the Apply button is clicked.

Circtime Override
By selecting Circtime Override, an alternate circulation period can be desig-
nated when checking an item Out. Before the item is circulated, the new Due 
Date or Loan Period must be entered in the Circtime Override field. The field 
will only be displayed if Circtime Override is selected. The value entered will 
override all other loan periods excluding the Global Due date. A setting 
within Global or Location Preferences will determine whether L4U requests a 
specific due date or the number of circulation days. To enable this setting, the 
Circtime Override needs only to be set once in Freedom Circulation. All sub-
sequent circulations will use this setting as long as the user remains logged in.

Display Client Picture
When the Display Client Picture option is selected, Circulation will display 
the Patron photo every time the Patron Code has been entered, and any time 
an item is returned by that Patron. The Patron picture must exist in the Client 
File for this feature to function.

Incoming Grace Day
When Incoming Grace Day is activated, L4U allows an item to be one day 
overdue without accruing fines. This feature is useful for libraries that have 
night drop boxes for returned items, or only check items In on specific days.

Disable Fines
When selected, Fines that would ordinarily be charged for items returned will 
not be charged to the Patron. Fines will not be charged as long as Disable 
Fines is selected.

Fine Warning On
When selected, Fine Warning On alerts the librarian to existing Fines condi-
tions or outstanding Fines. The operator can then allow or disallow additional 
circulations. For more information on Fines and Fine Payment, “Fine Pay-
ments” on page 148.

Show “Pay Fines”
If this option is selected, L4U will automatically display a payment message 
for any item that is checked in and has accrued a fine. Fine payments are then 
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processed by clicking the Fines and Charges tab. For more information, 
“Fine Payments” on page 148.

Items Out for a Patron
L4U provides a list of currently circulating items in a quick, at-a-glance format. Any-
time a Patron is entered in Freedom Circulation, a list of Current Items Out is dis-
played on the Freedom Circulation screen. These items are color coded for 
convenience. Printing from this window produces a printer friendly page.

The item just circulated to the patron is listed in Blue; Items listed in Black are items 
currently circulating, but are not overdue and Items listed in Red are Overdue.

From this screen it is easy to get Information on the Item and Renew the Item.

Item Information

Clicking on the Info 
button will reveal 
more information on 
the Item currently cir-
culating. Author, cost 
of the material and 
other useful informa-
tion for the forgetful 
patron is readily avail-
able.
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One Click Renewal
To quickly Renew an 
item, Click on the 
Renew icon. The item 
is renewed using the 
current settings for the 
Item and Patron. More 
information on 
Renewing Items is covered below.

Note: A Printer Friendly version of this 
page is available using the Web 
Browser’s Print function.

Lost Items
Items that are known to be missing should be marked with a status of Lost. If a patron 
has misplaced an item you will need to adjust the status of the item and make it 
unavailable for future circulation.

To change the status of an item to lost:

1. Locate the Patron with the lost item
2. Click the Info button for the lost 

item
3. Click Mark As Lost
4. Select one of the available options:

• No Charge The patron will not 
be billed

• Charge If the item does not 
have a Replacement Value, then enter the amount due

• Charge RV L4U will bill the patron the Replacement Value of the item
5. Click Save
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Renew Items
Items that are currently circulated Out to a patron can be renewed for either an addi-
tional loan period, or until a specified date. Renewals are accomplished by:

• Check the item In and back Out again: Maximum Number of Renewals will 
be ignored using this method

• One Click Renewal: see “One Click Renewal” on page 144
• Renewal Wizard: see “Web Renewal Wizard” below

Renewal Wizard Step 1

1. Enter the Patron in the Circulation win-
dow

2. Click Renewals
3. Either enter the new due date or use the 

pop-up Calendar to select a date.

• If no date is entered, the Loan Type’s Loan Period will be used to calculate 
the new due date

• If the date used to renew an item is greater than the Global or Location Due 
Date, the date will default to the Global or Location Due Date.

4. If necessary Select Renew Overdue Items
5. Do one of the following:

• To renew all items displayed, Click Renew all Items
• To renew specific items, Click each item to be renewed to place a check mark 

in the box beside the item. Click Renew Selected Items
• To return to circulation, Click Return to Circulation
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Renewal Wizard Step 2 - Renewal Preliminary Statistics 

1. Messages are displayed detailing which items may be renewed and which may 
not be renewed and why

2. To continue with the renewal, Click Renew
3. To go back to Step 1 without renewing, Click Go Back

Renewal Wizard Step 3 - Renewal Results

1. A final confirmation screen is displayed showing the items that were successfully 
renewed and the new Due Dates

To Continue working with the same Patron:

1. Click Return to Renewals
2. Click Return to Circulation

OR:

To Work with another Patron:

1. Click the Circulation button in the Freedom Toolbar 

Placing Reserves in Freedom Circulation
You can place reserves directly from Freedom Circulation. After a Patron is entered, 
perform a search for the item and click the Reserve button. Also, Reserves can be 
placed on all items in a Bookbag.
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Single Item Reserve

1. From the Freedom Circulation screen, Enter a patron
2. Click Search

3. Enter the Title or a portion of the Title
• L4U performs a Starts With search, ie: Search on CAT produces Cat, Cats, 

Cataclysm, etc.
• Start the search criteria with the L4U Wildcard: @ to perform a Contains 

search, ie: Search on @CAT produces Captain Cat, My Family Vacation, etc
4. Click the Query Icon to start the search
5. Click Reserve for the desired Title

Multiple Item Reserve

1. Create a bookbag of the item(s) to be reserved, see “Working with Bookbags” on 
page 55.

2. From the Freedom Circulation screen, Enter a patron
• The bookbag contents can also be created after the patron is entered.

3. Click the Reserves button
• To return to Freedom Circulation, Click Return to Circulation

4. Click Place a Reserve
5. Do one of the following:

• Select the checkboxes beside the items 
to reserve and Click Reserve Selected 
Items
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• Click Reserve All Items

6. The next page displays a listing of all the patron’s reserves
7. Click Return to Circulation to return to the Freedom Circulation screen

Deleting iPAC Reserves1
To view and delete reserves in Freedom Circulation:

1. From the Freedom Circulation screen, enter a patron
2. Click the Reserves button

• To return to Freedom Circulation, Click Return to Circulation
3. The iPAC reserves screen appears with all current reserves listed
4. Do one of the following:

• Select the checkboxes beside the items to be removed from reserves and 
Click Delete Selected Reserves

• Click Delete All Reserves
5. If everything is correct, Click Confirm

• To make adjustments before finalizing the deletion, Click Go Back
6. The next page displays a listing of all the patron’s reserves
7. Click Return to Circulation to return to the Freedom Circulation screen

Fine Payments
From Freedom Circulation, you can 

• View Returned Item Fines
• View Active Fines
• View Total Charges
• Add Other Charges
• View Patron Fine History
• Enter Payments to Fines and/or Other Charges
• Waive Fines and/or Other Charges

To access Fines and Charges:

1. From the Freedom Circulation screen, enter a patron.
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2. Click the Fines and Charges button.

3. Process the transactions as below.
4. To return to circulation at any point, Click Return to Circulation.

Returned Item Fines
Returned Item Fines are fines charged on overdue items that have been returned. Until 
an overdue item has been returned, fines that are accruing on the item appear in 
Active Fines. Returned Item Fines can be paid or waived.

Pay Fines

1. Ensure that the Returned Item Fines tab is selected
2. Check off in the Pay column, those items to which the payment is to be 

applied
3. Enter the payment amount in the Payment: field
4. Click Apply Payment
5. The Confirmation Page is displayed
6. To confirm the payment, Click Confirm

• To return to the Fines and Other Charges screen without applying 
the payment, Click Go Back

7. If the payment amount is greater that the total fines for the items 
selected, the amount will be displayed in the Change Due field.
• To return the change to the patron, Click Return Change
• To apply the change as a credit, Click Create Credit
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Waive Fines

1. Ensure that the Returned Item Fines tab is selected
2. Check off in the Waive column, those items whose fines you wish to 

waive
3. Click Waive Fines
4. The Confirmation Page is displayed
5. To confirm waiving the fines for these items, Click Confirm

• To return to the Fines and Other Charges screen without waiving the 
fines, Click Go Back

View Active Fines
Active Fines is the amount owing on items currently overdue and not yet returned. To 
view fines that have accrued on items that are still out, select the Active Fines tab.

Total Charges
Fines or charges may be incurred for reasons other than Overdues, such as lost items, 
photocopying, damaged materials, etc. These charges can be entered, paid or waived 
in Freedom Circulation.

Make a Payment

1. Ensure that the Total Charges tab is selected
2. Check off in the Pay column, those items to which the payment is to be 

applied
3. Enter the payment amount in the Payment field
4. Click Apply Payment
5. The Confirmation Page is displayed
6. To confirm the payment, Click Confirm

• To return to the Fines and Other Charges screen without applying 
the payment, Click Go Back

7. If the payment amount is greater that the total charges for the items 
selected, the amount will be displayed in the Change Due field.
• To return the change to the patron, Click Return Change
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• To apply the change as a credit, Click Create Credit

Waive a Charge

1. Ensure that the Total Charges tab is selected
2. Check off in the Waive column, those items for which charges are to be 

waived
3. Click Waive Charges
4. The Confirmation Page is displayed
5. To confirm waiving the charges for these items, Click Confirm

• To return to the Fines and Other Charges screen without waiving the 
fines, Click Go Back

Add a Charge
Charges incurred for reasons other than Overdues can be entered in Freedom Circula-
tion

1. To enter a new charge, ensure that the Add a Charge tab is selected

2. In the Description field, enter the nature of the charge
3. In the Amount field, enter the amount of the charge
4. Click Apply

• Click the Total Charges tab to view the new charge

Apply Credits
If overpayments have been applied to the patron’s account as a credit, then the credit 
may be applied to either fines or other charges. The process is very similar to applying 
a payment. To apply a credit:

1. Select either the Returned Item Fines tab or the Total Charges tab
2. Check off in the Pay column, those items to which the credit is to be applied
3. Click Apply Credit
4. The Confirmation Page is displayed
5. To confirm the application of the credit, Click Confirm

• To return to the Fines and Other Charges screen without applying the credit, 
Click Go Back

Client Fine History
All fines and other charges that have been paid or waived can be reviewed by select-
ing the Client Fine History tab. Information displayed includes the description of the 
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fine or charge, the date charged and paid/waived, the amount of the fine/charge and 
the amounts paid or waived.   

Circulation Alerts
Throughout Freedom Circulation, L4U uses various alerts or messages to notify the 
user of special circumstances. These can include patrons with overdues and/or fines, 
reserved items ready to be picked up or maximum number of borrowed items 
reached. When these messages appear, steps must be taken to either clear the message 
or provide L4U with the requested information. The following are examples of mes-
sages a user may encounter.

Client with Overdues
Overdue notices will appear when a patron with Overdues is entered in Circulation. 
The overdue items are displayed in red in the Item Info area.

Client with Fines
If a patron has outstanding fines, a warning message will appear. To allow circulation, 
Click Allow. To prevent further circulation to this patron, Click Disallow.
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Maximum Reached
If a Patron attempts to Circulate an additional item after his/her maximum number 
allowed is reached, a warning message will appear. To allow the circulation, Click 
Allow. To prevent circulation of the additional item, Click Disallow.

Returned Item has Accrued Fines
When an Overdue Item is checked back In, a warning message appears notifying the 
user that the item has accrued fines. This message only appears if Fines are being 
used, and the Show “Pay Fines” option has been activated.

Reserve Arrival Messages
If a patron is entered in Circulation and the item they have reserved is available, a 
notification message will appear. The message will appear each time the patron is 
entered, until the reserve is either deleted or the item circulated out to the patron.

Prior Reserves
Occasionally patrons attempt to borrow items that have been reserved for someone 
else. When the circulation attempt is made, a message will appear stating that a prior 
reserve exists. The user can then choose to circulate the item anyway by Clicking 
Allow or not by Clicking Disallow.

Suspended Client
If a Patron currently has a status of suspended, they are not permitted to borrow mate-
rials from the library. When a suspended Patron is entered in Circulation, an Alert will 
display and circulation will be prohibited.
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Account Expired
If a Patron currently has a Card Expiry Date that has passed, they are not permitted to 
borrow or renew materials from the Library. When a Patron with an expired account 
is entered in Circulation, an Alert will display. To clear the Alert, Click Allow or Dis-
allow as appropriate.

Bonus Reached
If a library chooses to award bonuses to patrons circulating a specified number of 
books, that value can be entered in Preferences. Once a patron reaches the designated 
number of circulations, L4U will display a message notifying the user that the bonus 
amount has been reached.

Temporary Barcodes
Occasionally a library collection contains items that are disposable or new items that 
have not yet been cataloged but are available for circulation. Users may wish to uti-
lize a temporary barcode to track the circulation of these types of items. A generic 
record must be created and posted to the Library File, see “To Create an Item Record” 
on page 82 for each temporary barcode number. Generic records must have a Depart-
ment of VF (Vertical File). Records assigned the Vertical File Department are 
designed to be defined at the time of circulation. 

To circulate an item as a temporary barcode:

1. In Circulation, Enter a client
2. Manually enter the Barcode or Title of the generic item
3. The Bibiliographic Note field displays, Enter the item description
4. Click OK

• This item has now been circulated Out

To circulate the item back In:

1. In Circulation, manually enter the Barcode or Title of the generic item
2. The Bibliographic Note field displays with the description of the item entered at 

the time of circulation
3. Click OK

• The item has now been circulated In

Note: If the library does not contain Vertical Files but does use the temporary bar-
code system, the VF department definition can be modified to read Tempo-
rary Barcode rather than Vertical File.

Circulation Period Hierarchy
When an Item is checked Out from the Library, the length of time the Item will circu-
late for is determined by several settings (Example: Loan Type, Client File, Circula-
tion, etc.).The circulation period can be controlled on several levels, therefore a 
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hierarchy must exist with specific settings always taking precedence over others. The 
hierarchy is listed below from lowest priority to highest.

Loan Type Code
Each item in the library collection has a mandatory Loan Type Code. Loan 
Type Codes are assigned a circulation period. When an item is circulated, its 
date due is based on the number of days in its designated loan type circulation 
period.

Note: The Loan Type Code can be configured to override the Client’s Circulation 
Override. To use this feature, see “Creating Loan Types” on page 75 in the 
L4U Users Manual.

Client Circulation Override
A Patron’s Circulation Override value will take precedence over the Loan 
Type Code circulation period. This setting is useful for patrons who require 
set circulation periods that usually exceed a normal Loan Type period. For 
Example: If a Patron with a Circulation Override of 10 days checks Out a 
book with a Loan Type Code set to 7 days, the due date will be 10 days from 
the current date.

Circtime Override
By selecting Circtime Override within Circulation, an alternative circulation 
period can be entered when checking an item Out. The value entered will 
override all other loan periods, excluding the Global Due date. A setting 
within Preferences will determine whether L4U requests a due date or the 
number of circulation days. To change this setting, “Circtime Override 
Options” on page 46 in the L4U Users Manual.

Global Due Date
This is the highest level in the circulation hierarchy. This date is set in Prefer-
ences and is the last possible due date. This date will override all other circu-
lation periods. Global Due Date can be used for collecting materials before an 
inventory or library closure. This date must be entered in the correct format 
for proper program functionality (MM/DD/YYYY).
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CHAPTER 8
RESERVES

Placing Reserves

Viewing and Modifying Reserves
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Placing Reserves
In L4U Freedom, it is possible to place a Reserve or Hold with a single click in the 
Circulation window or place a reserve on all the items in a bookbag. Also, a Reserve 
can be placed on an item that is currently in or out of the library.

Reserves are placed Circulation for the current patron. Please refer to “Placing 
Reserves in Freedom Circulation” on page 146 for more information on Single Item 
or Multiple Item Reserves.

Note: When multiple copies of an item exist, all copies will be Reserved. The circu-
lation of any of the copies to the patron will satisfy the Reserve.

Reserves in a Union Catalog with L4U Enterprise
A Union catalogue is the combined holdings of two or more libraries or collections. If 
the library administrator allows you to work or edit in more than one collection, L4U 
needs to know which collection your administrative tasks will affect. If so, Select a 
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location from the drop down list before performing Freedom administrative tasks. If 
the drop down list is not available, then you have access to only one collection. 

Viewing and Modifying Reserves
Existing Reserves can be viewed, modified and/or deleted from L4U Freedom. Also, 
patrons may view and modify their own reserves from their My Profile in the iPAC 
(see page 65). From the Reserves Management screen, administrators have the ability 
to delete or modify existing Reserves. To view existing Reserves:

1. In iPAC, login to Freedom, see “L4U Freedom Login” on page 66
2. Click Reserves Management in the Freedom Toolbar
3. Using the Quick Search feature, specific Reserves can be located. Please refer to 

“Quick Search” on page 112 for more information.
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4. To view the details of a specific Reserve, Double Click the record

5. Dates can be changed as necessary by Clicking in the appropriate field and Enter-
ing the new information

6. To Exit the record, Click Save
• To Exit without saving changes, Click Cancel

7. From the list view, Reserves can be sorted, queried and/or deleted. For more 
information on these functions, please see “Overview of Data Management” on 
page 112.
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Turning Inventory Off
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Inventory on the Web
Inventory can be performed at any location at any time. Inventory reports can be gen-
erated from Freedom Reports or the Admin Utility. Portable Inventory Scanners bar-
codes can be imported into Freedom too. Inventory via the web allows for remote 
inventory counts such as classroom bound textbooks or secondary locations for col-
lections housed in various buildings.

Best Practices
• Before starting Inventory, make sure to set a schedule, and stick to it. Place a 

reminder somewhere near the Inventory station to shut off Inventory on a spe-
cific date.

• If performing Inventory with a portable Inventory scanner, unpack the scan-
ner about a month before the Inventory is scheduled, and test to ensure that 
the scanner is working properly.

• All items currently out of the library are ignored during Inventory. It is 
assumed that if an item is out, its location is known, and therefore does not 
need to be inventoried.

• If time is a factor, Inventory can be processed one Loan Type at a time. If 
Inventory only needs to be processed for a few Loan Types, use this option 
for Inventory.

• Don't restart Inventory to count one or two Items that were missed during 
Inventory. Deal with the missed items on an individual basis though Library 
File.

• Don't change the Status of Library Items to Lost while Inventory is Active. 
Leave the item uncounted and L4U will automatically change the Status 
when the counts for that loan type are processed.

• Avoid adding or deleting items in the collection during Inventory. Changes to 
the data file should be done after Inventory is complete.
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Enable Inventory
Inventory must be enabled or turned on in Location Preferences before actual count-
ing of materials takes place. Currently, this is done in the Enterprise Administrative 
Utility (Admin Utility or AU). To turn Inventory on by Location:

1. From the Admin Utility, Authority Files>Locations
2. Open the desired Location
3. Click Preferences
4. Place a Check in the Inventory checkbox
5. Click Yes to confirm
6. Click Save to Exit Location Preferences
7. Click Save to return to the Locations window

Enable Inventory Access in Freedom
Now that Inventory is enabled, make sure that the people performing inventory have 
the correct web privileges to do so. Determine which Homeroom the people belong to 
and modify the Homeroom’s Web Privileges. It is assumed the patrons in the Home-
room have a PIN assigned to them so they can login. For more information on Web 
Privileges, please refer “Setting Web Privileges” on page 27 in the L4U Web Manual.

Note: Best Practice: Create a Patron called Inventory Clerk and put them in a 
Homeroom with just Inventory privileges. Give your Inventory assistants this 
web login and they can use any laptop as an Inventory only workstation.

Counting Inventory
Counting items can be accomplished in two ways:

• Scanning or manually entering barcodes into an Inventory screen
• Importing barcodes from an Inventory Scanner
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Scanning Barcodes using a Scanner
This is the most common method of counting items in L4U Inventory:

1. From the Freedom Home Page, click the Inventory icon
2. Scan or manually enter the item’s Accession Number (barcode) into the Enter 

Item Barcode: field
• L4U will beep and Item Status will indicate that the item is Added to Inven-

tory (ie: counted towards Inventory)
• If the barcode was manually entered, Click Proceed OR Press ENTER/RETURN 

on the keyboard
3. Repeat step 2 until all Items have been processed

• If an Item with a Status of In is scanned into a Circulation screen, it is circu-
lated Out and counted towards Inventory.

• If an Item with a Status of Out is scanned into a Circulation screen, it is circu-
lated In and counted towards Inventory. It's status will then be In Inventory.

• If an Item with a Status of In is scanned into an Inventory screen, it is counted 
towards Inventory. It doesn’t matter if you scan it multiple times.

• If an Item with a Status of Out is scanned into an Inventory screen, it is circu-
lated back In and counted towards Inventory. It's status will then be In Inven-
tory.

• If an Item with a Status of anything other than In or Out (eg: Missing, Lost, 
etc) is scanned into an Inventory screen, it is not counted towards Inventory 
and the Status remains as it was. Correct the status of the item in the Library 
File and then scan the item into an Inventory screen to count it towards Inven-
tory.

Importing Barcodes from a Portable Scanner
After scanning the barcodes with the portable scanner, they have to be transferred to 
the computer running Freedom Inventory. The barcodes are then imported into L4U. 
Please refer to the documentation that came with the scanner on how to transfer or 
upload the barcodes. Uploading barcodes using the CipherLAB CPT-711 Scanner is 
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described below. For more information on other L4U Inventory scanners, please refer 
to “Inventory using a Portable Scanner - Elite” on page 298 in the L4U Users Manual. 

Before attempting to upload scans to a computer, please ensure that the Keyspan USB 
Serial Adaptor, CPT-711 and desk cradle have been installed correctly as per the L4U 
Installation Instructions.

Upload Scans to the Computer

1. Place the CPT-711 Inventory Scanner in the Desk Cradle
2. Run the CPT-711 software from the CPT-711 icon on the computer desktop
3. Click the Menu Button in the CPT-711 software application 
4. Select Com Port Settings
5. Ensure the COM Port is set to COM 3 and click OK
6. Press the 2 Key on the CPT-711 Inventory Scanner keypad
7. Click the Menu Button in the CPT-711 software application 
8. Select Receive Data>Via RS-232 or IrDA
9. In the Save As dialogue box, Choose a location to save the file (e.g: computer 

desktop or a network share) and a file name for the saved text file (i.e. 
FictionInv02-04-2008.txt)

10. Once the upload is complete you will be given the option of viewing the data or 
not. If you do view the data, please ensure the file is Closed before proceeding to 
the next section Import Scans into Freedom Inventory.

11. At the CPT-711 Inventory Scanner it is advised to delete the scans on the scanner. 
To Delete the Scans:

• Press 1 on the key pad
• Press 1 on the key pad again
• The scans will now be deleted from the CPT-711 Inventory Scanner

12. The scans are uploaded to the computer

Import Scans into Freedom Inventory

1. From the Freedom Home Page, click the Inventory icon
2. From the Inventory Toolbar, Click Import 

Inventory File
3. Click Browse
4. Navigate to the location of the file containing 

the barcodes and Open it
5. Click Upload
6. Click Proceed

• If your scans have a checkdigit, Click 
Remove last digit (checkdigit)

7. A list of barcodes will appear with a status of 
each item. 



L4U Web Manual

166

8. Print or return to another Freedom module as appropriate.

Inventory Reports
Freedom can print inventory reports for partial or full inventories with different sort 
options. Inventory reports can be viewed or printed at any time while Inventory is 
enabled or active. To do so:

1. From the Freedom Toolbar, click the Reports icon
2. Click Inventory Statistics
3. Click Continue
4. Select which items to display for either:

• Full or Complete Inventory: Leave the Display Items drop down list at All 
Loan Type(s)

• Partial Inventory: Select the appropriate Loan Type from the Display Items 
drop down list

5. Select either Currently Inventoried (Counted) or Non Inventoried (Not Counted)
6. Select the desired Sort Order from the Select Sort Order: drop down list
7. Click Generate Report
8. A list of barcodes will appear with a status of each item
9. Print or return to another Freedom module as appropriate
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Inventory Reports After Inventory has Been Turned Off
Once Inventory has been turned off, the ability to print detailed inventory reports is 
limited. All that can been done is to use the Status Report and search the Status that 
was used to mark those Items as Lost when inventory was turned off. To do so:

1. From the Freedom Toolbar, click the Reports icon
2. Click Items Status Report
3. Click Continue
4. In the type Status Manually field, enter the Status that was assigned to Lost Items 

(i.e. Lost/20012)
5. Select the desired Sort option
6. Click Generate Report
7. Use the internet browser's Print function to print these items in a detailed report

Turning Inventory Off
Inventory should be turned off after all required reports have been printed and miss-
ing materials have been accounted for. The steps to Turning Inventory Off differs 
depending on which version of L4U you’re currently using. 

• Platinum Elite Users: Please refer to “Turning Inventory Off - Elite” on 
page 303 in the L4U Users Manual for more information

• L4U Enterprise Users: Please refer to “Turning Inventory Off” on page 307 
in the L4U Users Manual for more information
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Creating Patron History Reports

Creating Patron Fines/Other Charges Reports
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Online Reports in L4U Freedom
Reports can be quickly and easily produced in L4U Freedom. The reports fall into 
two categories - materials based or patron based. Overdue reports, materials currently 
circulating, fines and/or other charge reports can be quickly and easily generated.

Item Reports
Freedom Item Reports offers a variety of reports ranging from Items Out to statistics 
for Loan Types and Inventory. First select the type of report required, then narrow the 
scope of the report, specify the sort and Freedom will produce a predefined report.The 
different reports and what options are available are described in the following section.

Items Out or Overdue Report
Items Out, either overdue only or all items out for all homerooms or specific home-
rooms or patron are available. The options are similar for both Items Overdue and 
Items Out, so only the Items Overdue Report is shown below.

1. Log into L4U Freedom, see “L4U Freedom Login” on page 66.
2. Click Reports
3. Choose the desired report and 

click Continue
• Items Overdue Report - 

List of items overdue with 
options.

• Items Out Report - List of 
items currently circulat-
ing, including overdues.

4. Choose the Report Options
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• Auto-Search by Client Code/Client Name or Homeroom Code/Homeroom 
Name is available if the appropriate option is checked.

• Enter a portion of the Client Code/Client Last Name or Homeroom Code/
Homeroom Name.

• Select the desired Client or Homeroom from the drop down list.
• Specify the Sort Order from the drop down list.
• Check Include Hidden Departments if desired to include materials normally 

hidden from patron searches
• Check Print each Homeroom on a separate page to have each homeroom 

print on separate page
5. Click Generate Report to produce the report

• Click Reports Home or Go Back to return to the Online Reports
6. The desired report will appear on screen

• Use the drop down list to navigate to the other pages if more than one page is 
available

• Reports Home - returns to Online Reports
• Report Options - returns to the current Report Options page
• Back - returns to the previous page

7. To Print All Pages with the selected Page Break Option, Click Display All Pages
8. Print the Report using your internet browser’s Print command
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• Please consult the documentation or help files associated with your internet 
browser on how to Print

Note: A list of materials currently circulating for the patron can be produced from 
the Circulation window. Printing from this window produces a printer 
friendly page.

Overdue Reports by Email
L4U allows overdue notices or reminders to be emailed to Patrons or Homerooms. 
For this feature to operate properly, valid emails have to exist in the patron records 
(see “Additional Info” on page 131) and the homeroom files (see “Homerooms” on 
page 62 in the L4U Users Manual). The notice contains the selected details of the 
overdue items.

Email to Patron
Subject: Overdue Items from L4U Enterprise Training Library

L4U Enterprise Training Library is listing that you have 2 items 
overdue. The details of those overdue items are listed below:

Client Code: C0012
Client Name: Coyle, Greg
Accession #: 001393
Item Title: Culture smart!
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Due Date: Apr 22, 2009
Replacement $: $0.00
Fine accrued: $41.00
# Notifications: 0
etc...

Email to Homeroom Contact
L4U Enterprise Training Library is listing that your homeroom 
has 9 items Overdue. The details of those overdue items are 
listed below:

Client Code: C0251
Client Name: Bell, Taisia
Accession #: 000096
Item Title: Arthur's chicken pox.
Due Date: Oct 28, 2009
Replacement $: $0.00
Fine accrued: $0.00
# Notifications: 0
etc...

To email Overdue notices to Patrons:

1. Log into L4U Freedom, see “L4U 
Freedom Login” on page 66.

2. Click Reports from the Freedom Tool-
bar

3. Choose Items Overdue Report
4. Click Continue
5. Click Send Overdue Emails
6. Click OK at the confirmation dialog
7. Choose Report Style:

• Send to Patrons or Homeroom 
Email Address

• The example emails above had 
Replacement Value, Fine, # of Notifications option selected

8. Click Send Overdue Emails
9. A confirmation will appear providing a summary of successful emails, Click OK
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Note:  A single email will be sent to each homeroom email address. The email will 
contain a complete list of overdues for all individuals in the specified home-
room.

Item Status Report
The Item Status Report will produce a report based on the various Status’s that exist 
in the library collection. Alternatively, if the desired Status isn’t in the selection pop-
up, the Status can be entered manually. The report can then be sorted by a variety of 
fields to produce the desired report. This process is the same as for the Items Biblio-
graphic Report and is described in the next paragraph.

Items Bibliographic Report
The Item Bibliographic Report is a quick way to create reports for Authors, Titles, 
Subjects, Publishers and more. The report can then be sorted by key fields to produce 
the desired report. To create an Item Status or Bibliographic Report:

1. Log into L4U Freedom, see “L4U Freedom Login” on page 66.
2. Click Reports
3. Choose the Items Bibliographic 

Report and click Continue
4. Choose the Report Options

• Select the desired fields to 
search and/or sort

• Data Entry fields perform a 
Starts With search unless the search value starts with the L4U Wildcard, 
which is the @ symbol

5. Click Generate Report to produce the report
• Click Go Back to return to Reports Home

6. The desired report will appear on screen
• Use the drop down list to navigate to the other pages if more than one page is 

available.
• Reports Home - returns to Online Reports
• Report Options - returns to the current Report Options page.
• Back - returns to the previous page

7. Print the Report using your internet browser’s Print command
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• Please consult the documentation or help files associated with your internet 
browser on how to Print

Circulation Statistics
Use this report to generate a list of annual circulation statistics by the Loan Types in 
your collection. The desired date range can be selected as well as the sort order. These 
statistics are maintained until a Month End process is performed or the Circulation 
Statistics are zeroed during a Year End. Both of these processes are usually controlled 
by the District Librarian in an Enterprise configuration. To create a Circulation Statis-
tics Report:

1. Log into L4U Freedom, see “L4U Freedom Login” on page 66.
2. Click Reports
3. Choose Circulation Statistics and 

click Continue
4. Choose the Report Options

• Use the Calendar pop-ups to 
select a Start Date and End 
Date if desired
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• Select the Sort Order

5. Click Generate Report to produce the report
• Click Go Back to return to Reports Home

6. The desired report will appear on screen
• Use the drop down list to navigate to the other pages if more than one page is 

available.
• Reports Home - returns to Online Reports
• Report Options - returns to the current Report Options page.
• Back - returns to the previous page

7. Print the Report using your internet browser’s Print command
• Please consult the documentation or help files associated with your internet 

browser on how to Print

Inventory Statistics
These reports are used during the Inventory process. For more information on these 
Reports, please refer to the Inventory Chapter or more specifically, refer to “Inventory 
Reports” on page 166.

Patron Reports
There are a variety of Patron Reports available from within L4U Freedom. Patron 
lists by homeroom or by individual patron as well as circulation history and outstand-
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ing fines and other charges are available. The format of these reports are built-in to 
L4U and derive the header from the library information stored in Library Profile. The 
different reports are listed below with their various options.

Patron List Report

1. Log into L4U Freedom, see “L4U Freedom Login” on page 66.
2. Click Reports
3. Click Patron List Report
4. Click Continue
5. Choose the Report Options

• Auto-Search by Homeroom 
Code/Name or Client Code/Last 
Name is available if the appro-
priate option is checked.

• Enter a portion of the Home-
room Code/Name or Client 
Code/Name.

• Select the desired Homeroom or Client from the drop down list.
• Specify the Sort Order from the drop down list.
• Check Print each Homeroom on a separate page to have each homeroom 

print on separate page
6. Click Continue
7. The desired report will appear on screen

• Use the drop down list to navigate to the other pages if more than one page is 
available

• Reports Home - returns to Online Reports
• Report Options - returns to the current Report Options page
• Back - returns to the previous page

8. To Print All Pages with the selected Page Break Option, Click Display All Pages
9. Print the Report using your internet browser’s Print command
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10. Please consult the documentation or help files associated with your internet 
browser on how to Print

Patron Histories Report

1. Log into L4U Freedom, see “L4U Freedom Login” on page 66.
2. Click Reports
3. Click Patron Histories Report
4. Click Continue
5. Choose the Report Options

• Enter a portion of the Cli-
ent Code or Last Name.

• Select the desired Client 
from the drop down list.

• Optionally enter the Starting Date & Ending Date or select from the popup 
calendar.

• Specify the Sort Order from the drop down list.
6. Click Continue
7. The desired report will appear on screen

• Use the drop down list to navigate to the other pages if more than one page is 
available.

• Reports Home - returns to Online Reports
• Report Options - returns to the current Report Options page.
• Back - returns to the previous page

8. Print the Report using your internet browser’s Print command
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• Please consult the documentation or help files associated with your internet 
browser on how to Print

Patron Fines & Other Charges Report
Use this report to produce an invoice or receipt for fines or other charges. Select the 
appropriate option (or both if applicable) and the desired patron or homeroom. The 
report will list outstanding items still accruing fines, fines (paid or outstanding) and 
other charges (paid or outstanding) and waived fines or charges.

1. Log into L4U Freedom, see “L4U Freedom Login” on page 66.
2. Click Reports
3. Click Patron Fines/Other Charges Report
4. Click Continue
5. Click Other Charges to include any outstanding Other Charges
6. Click Fines to include Fines & Select what Type of Fines to report

• Outstanding Fines are fines charged on overdue items that have been 
returned.

• Active Fines is the amount owing on items currently overdue and not yet 
returned.
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• Outstanding and Active Fines are both of the above.
7. Choose the Report Options

• Auto-Search by Client 
Code/Client Last Name or 
Homeroom Code/Home-
room Name is available if 
the appropriate option is 
checked.

• Enter a portion of the Client Code/Client Name or Homeroom Code/Home-
room Name.

• Select the desired Client or Homeroom from the drop down list.
• Specify the Sort Order from the drop down list.
• Check Print each Homeroom on a separate page to have each homeroom 

print on separate page.
• Check Display zero balances rows to report on items with zero balances.

8. Click Continue
9. The desired report will appear on screen

• Use the drop down list to navigate to the other pages if more than one page is 
available

• Reports Home - returns to Online Reports
• Report Options - returns to the current Report Options page
• Back - returns to the previous page

10. To Print All Pages with the selected Page Break Option, Click Display All Pages
11. Print the Report using your internet browser’s Print command

• Please consult the documentation or help files associated with your internet 
browser on how to Print
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